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Chapter 1. Overview
Introducing MiDAS 4.0

MiDAS 4.0 is the fourth generation of Xcitex digital video and data capture control
software. MiDAS 4.0 is comprised of three editions: Express, Standard, and Full.
MiDAS 4.0 Express includes single camera control, frame-by-frame playback, and
image processing capabilities. MiDAS 4.0 Standard includes multiple camera control,
motion based video triggering, automation capabilities, measurement calipers, and
manual feature tracking. MiDAS 4.0 Full adds data acquisition control, video/data
synchronization, and data level based triggering to the features found in MiDAS 4.0
Standard.

New in MiDAS 4.0
MiDAS 4.0 retains the flexibility of earlier versions of the MiDAS software while
significantly extending the functionality of many features and simplifying complex
tasks. In addition to all the base functionality of previous versions of MiDAS, MiDAS
4.0 features:

• Data-only capture mode. Control data acquisition without having cameras
attached.

• 3-D Capture Wizard. Capture calibration images and videos using two cameras,
then transfer these files to ProAnalyst 3-D Professional software for motion
analysis.

• Auto-recording modes.

• Project based interface.

• Smart triggering.

• Distance and velocity calipers.

Updates and Support
MiDAS 4.0 is continually upgraded and improved. You may always download the
most current version of MiDAS 4.0 from the Xcitex web site at
http://www.xcitex.com/html/downloads.php. We at Xcitex encourage you to visit this
page frequently and update your software regularly. The MiDAS 4.0 installer software
built into MiDAS 4.0 will automatically update all the files on your computer to the
most current version. You can always find current technical support answers for

http://www.xcitex.com/html/downloads.php


MiDAS 4.0 and other Xcitex products at http://www.xcitex.com/techsupport.html.

The MiDAS 4.0 Manual on Your
Computer

This manual is automatically loaded onto your computer in PDF format when you
install the MiDAS 4.0 software. You can access it at any time by clicking on the
Windows Start button, selecting MiDAS 4.0, and then MiDAS 4.0 Manual from the
menu that appears. For additional printed manuals, send an e-mail to Xcitex at
<info@xcitex.com.>
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Chapter 2. Installing MiDAS 4.0
Before you start using MiDAS 4.0, first check that you have received all of the
components ordered. After unwrapping and checking the contents, follow the enclosed
instructions for installing and setting up your hardware and software.

What's Included
Depending on the package you have purchased, you should have received the
following.

All MiDAS 4.0 users should have received:

• MiDAS 4.0 Installation CD

• Example Files CD

• Security key

• Installation guide

• User guide

• License agreement

• Registration card

If you purchased a MiDAS 4.0 Data Acquisition package DA-123M, -132M, -160M,
-170M, you should also have:

• A Data Acquisition Board from National Instruments

• An 8-connector BNC Breakout Box (With jumpers pre-installed with use for
Midas 4.0)

• A 68-pin cable for connecting the DAQ board to the BNC Breakout Box

• BNC Female to female barrel connector.

• A 1-meter long coaxial cable with BNC connectors at each end

• A NIDAQ driver diskette from National Instruments

If you purchased a MiDAS 4.0 Data Acquisition package DA-160M, -161M, you



should also have:

• A Data Acquisition Board from National Instruments

• An 8-connector BNC Breakout Box (With jumpers pre-installed with use for
Midas 4.0)

• Two BNC female to female barrel connector.

• A 16-connector BNC Extension Breakout Box

• A 100 pin Y-cable for connecting the DAQ board to the two BNC Breakout Boxes

• Two 1-meter long coaxial cable with BNC connectors at each end

• A NIDAQ driver diskette from National Instruments

Additionally, you should have the hardware and software for any camera/s that you
wish to install to use with MiDAS 4.0

Install the Camera Hardware and
Drivers (PCI card based)

1. Remove the cover from your computer case.

WARNING: Prior to installing boards in your computer, disconnect the power to
the computer. Make sure you are properly grounded using a wrist ground strap.

2. In an open PCI slot, install the video camera board in your computer, and attach
the cable and camera head in accordance with the instructions from the
manufacturer.

3. Turn on the computer and install the camera driver software in accordance with
the instructions from the manufacturer.

4. Re-boot the computer when instructed to.

5. Test your camera in accordance with the instructions of the manufacturer. Make
sure you can open a camera and are successfull at getting an image on the screen
before continuing.

6. Repeat Steps 2-5 for each camera type to be installed in the computer.

7. Re-install the cover for your computer case, and re-insert the power cord, as well
as any other cables and accesories.
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Install the Camera Hardware and
Drivers (USB, IEEE 1394, or ethernet
based)

1. Turn on the computer and install the camera driver software in accordance with
the instructions from the manufacturer.

2. Re-boot the computer if instructed to.

3. Once the computer has re-started you can plug in your camera.

4. Windows should locate your camera and install it.

5. For ethernet cameras, follow the manufacturer's instructions to configure the the
camera's I.P. address.

6. Test your camera in accordance with the instructions of the manufacturer. Make
sure you can open a camera and successfully get an image on the screen before
continuing.

7. Repeat Steps 1-6 for each camera type to be installed in the computer.

Install the (optional) Data Acquisition
Hardware (PCI based)

Note: If you did not purchase a MiDAS 4.0 DAQ hardware kit, you may skip this
section. All MiDAS 4.0 DAQ hardware kits include a data acquisition board, a BNC
Breakout Box (or multiple BNC Breakout Boxes). If you also purchased an optional
MiDAS 4.0 Terminal Block, connect the BNC Breakout Box as described below, then
follow the instructions listed in Chapter 7, Data Acquisition Theory.

WARNING: Prior to installing boards in your computer, disconnect the power to the
computer. Make sure you are properly grounded using a wrist ground strap.

1. In an open PCI slot, install the data acquisition board.

2. If you purchased a DA-123M, or DA-170M kit, connect one end of the 68-pin
shielded cable to the back panel connector of your data acquisition board. Then
connect the other end of the cable to your BNC Breakout Box as shown in the
following figure:
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3. If you purchased a DA -171M kit, connect the large end of the -100-pin shielded
"Y" cable to the back panel connector of your data acquisition board. Then
connect the other end of the cable labeled "MIO16" to your MiDAS 4.0 BNC
Breakout Box and the other end of the cable labeled "Extended I/O MIO64" to
the Extended Breakout Box, as shown in the following figure:

4. Your MiDAS BNC Breakout Box comes pre-configured with two jumpers in
place, as shown in the following figure:

Confirm that the first jumper is securely affixed to both PFI4 and User2
terminals. Confirm that the second jumper is securely affixed to both PFI1 and
CTR1Out terminals.

5. Continue to Section 6 Install the Data Acquisition Drivers (Software)
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Install the (optional) Data Acquisition
Hardware (PCMCIA based)

Note: If you did not purchase a MiDAS 4.0 DAQ hardware kit, you may skip this
section. The following instructions are for PCMCIA-based DAQ hardware kits only.
All MiDAS 4.0 DAQ hardware kits include a data acquisition board, a BNC Breakout
Box (or multiple BNC Breakout Boxes). If you also purchased an optional MiDAS 4.0
Terminal Block, connect the BNC Breakout Box as described below, then follow the
instructions listed in Chapter 7, Data Acquisition Theory.

1. Insert the PCMCIA card in any open PCMCIA slot in your laptop.

2. Connect one end of the 68-pin shielded cable to the back panel connector of your
data acquisition board. Then connect the other end of the cable to your BNC
Breakout Box.

3. Your MiDAS BNC Breakout Box comes pre-configured with two jumpers in
place, as shown in the following figure:

Confirm that the first jumper is securely affixed to both PFI4 and User2
terminals. Confirm that the second jumper is securely affixed to both PFI1 and
CTR1Out terminals.

4. Continue to Section 6 Install the Data Acquisition Drivers (Software)

Install the Data Acquisition Drivers
(Software)

Note: If you did not purchase a MiDAS 4.0 DAQ hardware kit, you may skip this
section.
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1. Turn on your computer.

2. Insert the "NI-DAQ" driver CD from National Instruments (Disk 1). The driver
installation program should start automatically. If it does not, enter the letter of
your CD-ROM drive in the Run... prompt (Start menu).

Note: You MUST be logged in as the Windows Administrator to properly install
MiDAS 4.0. Users without administrative privileges will not be able to
successfully install key MiDAS drivers.

3. Click on Install NIDAQ at the first screen.

4. Follow the instructions on the screens to load the NI-PAL, MS Runtime and
NIDAQ drivers for your model DAQ board.

Note: The model DAQ board is automatically detected and determined by the
software. The appropriate driver(s) will be automatically installed.

5. Re-boot the computer when instructed.

6. After the re-boot, the NIDAQ Setup Routine will continue. Follow the
instructions in the program.

7. At the NIDAQ Setup screen, it is not necessary to choose any additional
documentation. Check the checkbox on the screen to decline installing further
documents. Click on the Next button.

8. At the Select Development Platform screen, it is again not necessary to choose
any development platforms at this time - the development libraries are
automatically loaded with the MiDAS 4.0 disc. Click on the Next button.

9. Select the Configure Measurement and Automation checkbox and click the
Finish button. If the Measurement and Automation Explorer does not
automatically appear, double click on the National Instruments Measurement and
Automation icon on your desktop. The following screen will appear:

10. Click on the + sign next to the "Devices and Interfaces" folder. You should see
the internal model number of your data acquisition board listed below. If you do
not see the board number, the system does not recognize the existence of your
hardware. You must quit, turn your computer off and re-seat the board in the PCI
slot, then repeat Step 6.
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11. Right click on the board number and select Test Panel. The following screen will
appear:

12. Without any signal hooked up, you should see a noisy waveform (a line across
the screen that varies or simply drifts up and down in time) and no error messages
listed on the right side of the Test Panel. If you receive an error message, remove
and reinstall the drivers starting at Step 1.

13. Remove the disk at this time. Re-boot your computer.

Install the MiDAS 4.0 Software

1. Turn on your computer.

2. Insert the CD-ROM that contains the MiDAS 4.0 software. The MiDAS 4.0
software installer should automatically start. If it does not, from the Run...
prompt, type F:/SETUP, where "F" is the drive letter of your CD drive.

3. Follow the instructions on the screens to install the MiDAS 4.0 software and
documentation. For more detailed information, refer to the MiDAS 4.0
Installation Guide included in the software box.

4. Continue to follow the on-screen installation procedures. When instructed by the
software, remove the CD-ROM from your CD drive.

5. Re-boot your computer. Before starting MiDAS 4.0, you must first attach your
MiDAS 4.0 security key and run the MiDAS 4.0 License Manager. Within the
License Manager, you will enter and enable your license number. This is required
before you can run MiDAS 4.0.

Run the MiDAS 4.0 License Manager
Upon purchase, the MiDAS 4.0 software comes with
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• A security key (also known as a dongle)

• A 35-day license code

Together the security key and license key code protect the MiDAS 4.0 software from
unlicensed use. The security key is a physical device that attaches to a USB port or the
printer port of your computer. MiDAS 4.0 frequently seeks out the existence of the
security key to confirm that you are a licensed user of MiDAS 4.0. The security key
also provides a method for MiDAS 4.0 to keep track of the edition of MiDAS 4.0 that
you have licensed.

You must run the MiDAS 4.0 License Manager upon installation to inform the
software that you are a registered user and to enable the features for the software
edition you have purchased.

1. If using a printer port (parallel port) security key, remove any printers attached to
your computer.

2. Attach your MiDAS 4.0 security key to the computer's USB port or parallel port.
If a parallel port security key, reconnect any printers to the security key.

3. To run the MiDAS 4.0 License Manager, MiDAS 4.0 > MiDAS 4.0 License
Manager in the Programs group of the Windows Start menu.
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4. Enter the 35-day license code printed on the back of your Installation CD case. If
you have already registered your software, enter the permanent license code sent
to you via e-mail.

5. Click on Check License. If you have entered the license code correctly,
information about the security key, license code, and software will appear in the
lower text box. The Enable Licensebutton will also become highlighted.

6. Click on the Enable License button.

7. You may now exit the MiDAS 4.0 License Manager.
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Chapter 3. Fundamentals
Understanding How MiDAS 4.0 Works

MiDAS 4.0 utilizes an organizational hierarchy based on Projects. A Project is a
collection of video and/or data files. MiDAS 4.0 handles two types of projects.
Record projects are a collection of device settings allowing you to easily duplicate
previous setups. Play projects are a collection of previously recorded video and data
files. When MiDAS 4.0 is in Record mode, it displays the controls necessary to
configure and execute a recording - for example, the frame rate or acquisition
frequency and resolution of the camera and data device. In Play mode, MiDAS 4.0
displays the controls necessary to play, process, and analyze recorded video and data.

MiDAS 4.0 Display Settings
The MiDAS 4.0 window colors and resolution can be changed only by modifying
Windows display settings.

Note: While MiDAS 4.0 is designed to operate with a resolution as low as 1024 x 768
pixels, the optimal viewing resolutions is at least 1280 x 1024 pixels (or equivalent,
depending upon aspect ratio). We recommend using the highest resolution that you
are comfortable with. We also recommend a minimum color depth of 24-bit. If your
color depth is not at least 16-bit, MiDAS 4.0 will give an error message.

The resolution of any video window will actively update during resizing. To resize a
video window, click and drag on its border. Grab one side of the window border to
change only the horizontal or vertical dimension. Grab the corner of the window to
change the horizontal and vertical dimensions simultaneously. MiDAS 4.0 will always
maintain the aspect ratio of the video image.

Note: If your displayed window resolution does not update in real time during
resizing, you must make the following changes in your Windows settings:

1. Click on the Windows Start button.

2. Click on Control Panel.

3. Click on Display.

4. Click on the Appearance tab.

5. Click on the Effects... button. A dialog box will appear.

6. Make sure the Show Window Contents While Dragging check box is selected.



The MiDAS 4.0 Interface
The MiDAS 4.0 interface is modeled on conventional Windows program interfaces. If
you are already familiar with MiDAS 2.0 or other previous versions of MiDAS, you
will recognize many of the elements in MiDAS 4.0.

Settings and tools are accessed via the menu bar at the top of the program window and
the toolbar directly below the menu bar. The menu bar allows the user to control
general program features and settings, while the toolbar contains buttons for
commonly used MiDAS 4.0 functions.

The MiDAS 4.0 interface consists of 4 main areas: the Program Window, the Project
Window(s), the Control Panel, and the Play Controls Panel.

• The Program Window contains the overall MiDAS 4.0 application. Menu items in
the Program Window control settings that apply across all projects and the MiDAS
4.0 application itself. The Program Window encloses the Project Window(s), the
Control Panel, and the Play Controls Panel.

• The Project Window(s) contains video and/or data windows. While in Record
mode, the project window displays live video and data feeds from active cameras
and other devices. While in Play mode, the project window displays the recorded
video and data for playback.

• The Control Panel is docked on the left of the Program Window when MiDAS 4.0
is first opened. A series of vertical tabs on the side of the control panel allow the
user to configure video/data acquisition, processing, and analysis.

• The Play Controls Panel is controlled by the Toggle Play Controls button on
the toolbar. This button will allow you to switch between different types and
locations of the Play Controls Panel.

MiDAS 4.0 utilizes tool tips to help the user identify the function of buttons on the
toolbar. To view a tool tip, simply place the mouse cursor over the button without
clicking.

The Title Bar
All of the windows in MiDAS 4.0 use the same format for the title bar, shown below.
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The Menu Bar
The MiDAS 4.0 menu bar spans the top of the program window, immediately below
the title bar. The menu bar allows you to access the universal program controls and
common actions such as opening cameras, opening files, and saving files. The
following are the MiDAS 4.0 menu bar options:

Open Play Group...
Save Play Group File As...
Open Video File...
Open Data File...
Save Video/Data File As...
Save Recorded Parameters
Save MiDAS Notes
Open Camera
Open Data Card...
Open Record Configuration...
Save Record Configuration As...
Close
Export Data To Text...
Export Data to Excel...
Print...
Print Preview
Print Setup...
Exit

Undo
Cut
Copy
Paste
Edit Record Parameteters...
Program Options...
Record Options

Main Toolbar
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Group Layout Toolbar
Video Controls Toolbar
Video Tools Toolbar
Control Panel
Play Controls
Status Bar
Data-centric Graph
Video-centric Graph
Play Controller - Settings from Active
Play Controller - Settings from Slowest

Connection Assistant
Lens Calculator
Video Explorer
MiDAS Notes
MiDAS 2.0 Conversion Wizard
ProAnalyst 3-D Capture Wizard

Cascade
Tile
Close All in Current Group
Close Current Group
Close All Groups

Register...
Check for Updates...
About...

The Toolbar
The MiDAS 4.0 toolbar is directly below the menu bar. It provides controls for the
most commonly used features of MiDAS 4.0. Toolbar buttons can be un-docked and
moved anywhere on your screen. All toolbar buttons have tool tips.

Main Toolbar

The Main Toolbar consists of basic file control buttons.

New play group

Open video, data, or play group file
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Save play group or record configuration

Save active playback

Help

Layout Toolbar

The Layout Toolbar consists of a variety of project environment buttons.

Play controller settings from active window

Play controller settings from slowest video source in group

Show control panel

Hide control panel

Auto arrange windows now

Toggle auto arrange windows

Video Controls Toolbar

The Video Controls toolbar contains the basic video manipulation buttons.

View actual size

Fit in window

Pan

Zoom

Show reticle

Show ruler

Video Tools Toolbar

Chapter 3. Fundamentals 17



The Video Tools toolbar consists of the zoom buttons.

Define zoom region

Set zoom region

Show zoom region

Remove zoom region

Video Measurement toolbar

The Video Measurement toolbar consists of measurement buttons.

Add measurement point

Add scale calibration

Show video information

Add go to note

The Status Bar
At the bottom of the program window is the status bar. The status bar provides size
information about the active video window, in pixels.

Window Types
Images and data are displayed within their own window in the MiDAS 4.0
environment. Each window is self contained. The appearance of these windows is
based upon your Windows theme settings.

The types of windows found within your MiDAS 4.0 projects are as follows:

Camera View Window This window displays a live view from a
camera. The camera view window is the
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current sensor image and is controlled by
the camera. If the camera displays live
images during recording, (and you have
enabled this under Edit > Record
Options...) the image will be visible here.

Zooming, panning, and resizing are all
available for the Live camera window.
NOTE: The video display window will
automatically minimize to an icon when
the recording is complete, and a playback
window will be made active.

Playback Window
This window displays recorded videos.
You can interact with these recordings
using the toolbar or the play controls in
the Play Controls Panel. Multiple
playback windows can be displayed and
synchronized.

Zooming, panning, and resizing are all
available for the Playback window

Zoom Window
This is a daughter window of a Camera or
Playback window. It will display a zoom
view of an area defined by the user.

Data Window
This window displays a data graph. You
can interact with this window
independently, or you can synchronize it
to the appropriate video window. It can be
scaled to show you the range of data you
are interested in.

The title bar will provide information on the window type. Camera view windows will
show the name of the camera, and Live or Recording, plus a sequential number.
Playback windows have a camera icon and show either the camera name, or, if it
contains a previously recorded file, the file name and type. Data windows have a
graph icon and show either the data sensor name, or, if it contains a previously saved
file, the file name and type.

Working with Video Windows
There are three components to MiDAS 4.0 Camera View and Playback windows - the
window frame, the actual image, and the visible region of the image.
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The "Window Frame" is the outside container of the window.

The "Actual Image Size" is the size at which the image was recorded.

The "Visible Region Size" describes the portion of the recorded image that is visible
within the window frame

The "Zoomed Image Size" describes the on-screen dimensions of the image within the
window frame.

For example, the following image of a ski jumper was recorded at 480 x 420 pixels:
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The dimensions of the zoom region, the head of the player, are 76 x 80 pixels:

The zoom region is enlarged to fit a window frame of 320 x 340 pixels:

In this example, the MiDAS 4.0 status bar will report the following dimensions:

• Actual Image Size: 480 x 420

• Visible Region Size: 76 x 80
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• Zoomed Image Size: 320 x 340

In this example, zoom region is magnified approximately 4 times (320 x 340 divided
by 76 x 80 approximately equals 4) to fit in the window frame.

Magnification of the image can be achieved in any of the following ways:

• Increase the size of the window frame by clicking and dragging on the frame
edges.

• Increasing the zoom of the region. This can be done by clicking on the zoom
button on the toolbar or by right-clicking on the image and choosing Zoom in
the contextual menu.

Note: A zoom ratio of 1 means that the image and the frame are the same size. A zoom
ratio greater than 1 means the image is larger than the window frame, and only a
portion of the image (i.e. the zoom region) is displayed within the window frame.

If only a portion of the original image is visible in the active window, i.e., the image is
magnified, a small zoom map will be appear in the upper right hand corner of the
image. The zoom map indicates the location and size of the visible region relative to
the overall image. The zoom map position may be changed by right-clicking within
the window and selecting Show Zoom Box in the contextual menu.

To expand the active window to the Maximum size, click on the maximize button
within the window title bar . To return to its previous size, click on the restore down
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button . To minimize the window, click the minimize button .

Contextual Menus
In MiDAS 4.0, camera, play, and zoom windows share a common set of contextual
menus, which are accessed by right-clicking within the active window. The View
options are View Actual, Fit in Window, Pan Mode, Zoom Mode, Show Reticle, Show
Rulers, Show Information, and Show Zoom Box.

The Analysis options are View Calibration and Clear.
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Each option is described below.

View Actual When selected, this command sets the
zoom region and the window frame to be
equal to the actual image size.

Fit in Window When selected, this command fits the
entire image within the window frame.
This command does not change the
window frame size, just the image size
whithin the window frame.

Pan Mode Pan mode allows you to use your mouse
or trackball to easily pan the image. Click
and hold the left mouse button and drag
(or roll the trackball) to move the image
to your desired position.

Zoom Mode Zoom mode allows you to use your
mouse or trackball to increase or decrease
the magnification of the image. Click and
drag the mouse up to zoom in or down to
zoom out. Alternatively, roll the mouse
scroll wheel forward to zoom in or
backward to zoom out.

Note: During zooming, the geometric
center of the image remains constant.

Show Reticle This command toggles the display of a
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reticle (crosshair) in the image. The
reticle coordinates will be displayed in the
status bar. Left-clicking within the image
will reposition the reticle.

Note: You cannot reposition the reticle
while in Pan Mode or Zoom Mode.
Deselect Pan Mode or Zoom Mode before
attempting to reposition the reticle.

Show Rulers This command displays rulers at the
borders of the active window. The ruler
units are pixels.

Show Information This command allows you to specify
where in the active window you would
like to display information about that
video (frame number, time, recorded rate,
shutter speed, and reticle position if
applicable). You can also hide this
information by selecting Hide.

Show Zoom Box This command allows you to specify
where in the active window you would
like the zoom box displayed. The zoom
box shows you the zoom ratio - the size of
the zoom region relative to the actual
image size - and the position of the zoom
region relative to the actual image. The
status bar indicates the size of the zoom
region in pixels. You can also hide the
Zoom box by selecting Hide.

View Calibration When selected, the x and y axes and two
scale calibration points will be visible on
the image. The calibration properties are
set in the Calibration tab of the Control
Panel.

Clear Selecting Clear All Forward clears feature
tracking points in subsequent frames.
Feature tracking is applied using the
Analysis tab of the Control Panel. The
Clear action cannot be undone.

Working with Data Windows
Data windows have their own set of viewing options. At the top of the data window,
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three radio buttons allow you to switch between Cursor, Zoom, and Pan modes.

The Data Playback window has a waveform display with some select features along
the top. A single blue cursor shows the location of the video/data counter, in data
points. Along the bottom, the time position is displayed. The features of the Data
Playback window are as follows:

Edit Mode: Cursor When the Cursor mode button is selected, the
user has control of the cursor with the mouse.
By clicking and dragging the cursor, both the
video frames and data will advance forward or
backward synchronously.

A jump advance feature is also provided - just
click anywhere within the graph area and the
cursor jumps to that position the video will
jump to the corresponding frame.

Edit Mode: Zoom When the Zoom mode button is selected, the
user can change the zoom magnification of the
waveform window. Simply click and drag
within the graph area to select a zoom region.
When the mouse is released, the zoom region is
expanded to fill the graph area.

Double-click anywhere within the graph area to
return to the original view.

Edit Mode: Pan When the Pan mode button is selected, the user
can click and drag on the graph area to move
the graph in any direction. Double-click
anywhere within the graph area to return to the
original view.

Display Values When checked, the right side of the Data
Playback window will display the cursor values
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for all the active channels.

Data Index The current data point number of the current
acquisition. Note that the data index is not the
same as the frame number since multiple data
points can be acquired per frame of video

Time The current time position of the cursor and the
video.

To modify the appearance of the Data Window, follow these steps:

1. Open a Data Graph Window, as shown above.

2. Click on the Configure Graph button. The Graph configuration window appears:

The top half of the window is for selecting the active channels to display. To
activate or deactivate any channels, use the ADD and REMOVE buttons. The
Displayed channels are shown on the right side of the dialogue box. The Not
Displayed channels are shown on the left side. To move, simply highlight the
channel of interest and press the ADD or REMOVE buttons.

The bottom half of the window contains the following selection information:

Use Units When this option is selected, the Y-axis
(vertical axis) is displayed in the configured
engineering units rather than volts.

Y Label from Channel x When selected, this option calculates the
maximum of the Y-axis label with the data
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from the selected channel (must be an active
channel). If only one channel is active, or if
this checkbox is unselected, the Y-axis
maximum value will be calculated as the
maximum of the first active channel.

OK Saves the settings and returns to the main
Data Playback window.

The Control Panel
The tabs contained within the Control Panel are the primary means of interacting with
MiDAS 4.0. By clicking on the various tabs on the left hand side of the control panel,
such as Playback or Record, specialized controls for that particular tab are presented.
The Control Panel tab labels are displayed in three colors. Red labels relate to
recording, blue labels relate to playback and analysis, and the green label is for image
processing.

The Control Panel contents change automatically depending on the mode MiDAS 4.0
is in currently. The Record tab is visible during camera control. The Playback tab is
automatically moved to the front when recording is complete.

The Control Panel is docked on the left side of the MiDAS 4.0 window by default. It
can also be un-docked and repositioned anywhere on the computer screen. To un-dock
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the Control Panel, double-click near the top of the docked region of the Control Panel.

To re-dock the Control Panel, you can double click the title bar of the Control Panel.

Alternatively, you can drag the window to the left or the right side of the Console area.
If you would like to move the Control Panel near the edges of the program window
without docking, press and hold the CTRL key while dragging the Control Panel
window. Hide and show the Control Panel using the Hide Control Panel and Show
Control Panel buttons on the toolbar.

Note: If you have dragged the Control Panel window off the lower portion of the
screen and you cannot get it to reappear, it is likely that the window is hidden beneath
the Windows Taskbar. In order to uncover the window, click and drag the Windows
Taskbar to the right, left, or top of the screen temporarily. This should reveal the
Control Panel window, which you can then drag back towards the center of the
screen.

Note: The MiDAS 4.0 convention is to show those parameters that are set by the
operator in white. Items in gray are not accessible.

Program Options
The following are program-wide options that will affect how you use the MiDAS 4.0
software.

Select Program Options... from the Edit menu. A dialog box will appear with three
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tabs: General Settings, Camera Scanning, and Camera Connections.

Basic Interface (single Play Group
window only).

When selected, this option will enable the
standard MiDAS 4.0 interface. This will
limit MiDAS 4.0 to opening only one
record and play group at a time.

Start new Play Groups maximized. This option is enabled by default and
maximizes the size of any play or record
group within the MiDAS 4.0 program
window.

Automatically open similarly named
files.

Enabling this option will open all image
files with the same file name but different
numerical appendix, e.g. Image01.jpg,
Image02.jpg, Image03.jpg. This is
used when the video has been saved as a
sequence of individual image files. If you
will often be opening only parts of a
sequence regularly, you should turn this
option off and choose the individual
images using the mouse-left-click+[shift
key], to select the desired range.

Prompt for verification when closing
from device memory.

This is a safety feature to assure that data
that has just been recorded is not lost.
With this enabled, if you try to close a
fresh record window, MiDAS 4.0 will
prompt you with a dialog box before
closing the window. It is not
recommended that you turn this option
off.

Restore Defaults This will revert the Program Option
settings to the default values.

The Camera Scanning tab lists the most popular cameras supported by MiDAS 4.0.
MiDAS 4.0 will search for the camera models that are selected. Clicking Restore
Defaults will check all camera models.

The Camera Connections tab allows you to set the type of connection used by your
camera.

Record Options
The following are program-wide options that will effect how MiDAS 4.0 records.

Select Record Options... from the Edit menu. A dialogue box will appear with the
following options:
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Live video display while recording (if
supported).

This will keep the live video window
from minimizing during recording, for
cameras that allow this feature.

Live Data Graphing while recording. This will allow the user to have the data
display report the recorded data values
during a recording. These values will
update as quickly as the hardware and
software drivers will allow.

Record busy dialog. This option controls whether the
recording busy dialog is displayed during
recordings. This may be helpful if a live
window is displayed during recording,
and the "record busy" dialog box may
block an important portion of the image.

(Synchronization options) First device
slave

This option is utilized if the master for a
capture event is to be a device not under
MiDAS control. MiDAS assumes that the
first device opened is the master in any
record event. This selection takes the
master device priority away from MiDAS
and gives it to a third party device or
application.

(Synchronization options)
Synchronized recording

This will automatically sync all live
camera windows for recording
simultaneously when a recording is
started.

Default Live Frame Rate This will set the refresh rate for the Live
video window. The default value is set to
5 to save on processor cycles and data
buss bandwidth. Available values are
between 1 and 15.

Restore Defaults This will revert the HG setting to the
default values.

System Memory Utilization This setting will allocate a certain
percentage of system memory to data
from your Data Acquisition system. The
available percentages are between 1%
and 10%.

Restore Defaults This will revert the Data setting to the
default values.
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The Play Controls
There are four types of Play Controls to let you modify your workspace to your
preference.

1. Standard play bar.

2. Thin, or abridged play bar.

3. Long Play Bar used for greater slider resolution.

4. Play Control panel, docked under the control panel.

You can switch between the four panels by clicking on the Play Controls icon on the
toolbar . Play Controls include the following functions:

Play Controls Jump to first frame

Play backward

Play forward

Stop

Step back one frame

Step forward one frame
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Jump to last frame

The slide bar allows you to quickly move
to a specific part of the video.

Frame and Time The frame number and time stamp
relative to the trigger event are displayed
next to the play controls.

Synchronization Options The C checkbox selects a continuous
playback mode. When this option is
selected, the video will play in a loop,
going back to the beginning of the video
when it reaches the last frame.

The S checkbox selects synchronized
playback. This option allows for the
synchronization of the playback of
multiple video files. When synchonized,
two or more videos and data sets will play
at the same frame rate.

The B checkbox (base synchronization)
will be automatically checked when
opening a play group that utilizes it. Base
Synchronization is the inherent
synchronization of a video and data set
that was recorded together originally. It is
normal to keep this synchronization in
place during playback.

Playback Rate Set the playback
rate by clicking and dragging the slider
post towards the right or left. The actual
playback rate is determined by many
factors, including the number of
synchornized videos, the video RAM, and
the speed of the computer processor. The
average playback rate may be displayed
below the playback rate slider in frames
per second (fps).

Playback Ratio The playback ratio setting allows you to
select the ratio of frames displayed to
actual frames. A ratio of 1:n plays every n
frames and increases the playback rate.
Adjust the value of n by clicking on the
up and down arrow buttons.

Chapter 3. Fundamentals 33



Jump Enter a frame number in the text field and
click the Jump button to go to that frame.

Zero Click the Zero button to set the current
video frame and its corresponding data
point as the zero reference. Video frames
and data points prior to the zero reference
will numbered with negative values.
Video frames and data points after the
zero reference will be numbered with
positive values.
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Chapter 4. Recording Projects
This section describes the basic features used in MiDAS 4.0 for recording video. The
term video in this section is interchangeably defined as either 1. a single file that
contains all the frames, or 2. a sequence of image files, numbered sequentially for
playback in the correct order. The most common video format is .AVI. The most
common formats for image sequences are .BMP or .JPG.

Acquiring video is the principal function of MiDAS 4.0. MiDAS 4.0 controls video
cameras through their standard communication protocol, configuring video
acquisition. MiDAS 4.0 allows you to control video acquisition using its own software
triggers, external hardware triggers or the automation modes explained in Chapter 6,
Automation. In addition, MiDAS 4.0 can capture video synchronized with external
data as explained in other sections of this manual. This section describes the basics of
video acquisition and instructions for acquiring video only.

Opening and Configuring Cameras
Begin by opening a new Record project if you do not already have one open, either by
selecting New Group from the File menu or by clicking on the New Play Group button

on the toolbar. Note that you can only have one Record project open at a time.

Connect your camera(s) per the instructions in Chapter 2, Installing MiDAS 4.0. If you
have multiple cameras in your system, connect the hardware as depicted in the
MiDAS 4.0 Connection Assistant.

Go to Open Camera... in the File menu. A dialog box will appear, prompting you to
select the hardware family of your camera.



This list is populated based on the selections you make in the Camera Scanning tab in
Program Options..., selected from the Edit menu. You can reduce the list to the family
of cameras you normally work with. Select the appropriate family and click on Scan.
If your camera is properly connected and configured, it will appear in the Available
Devices field.

Select the desired camera from the Available Devices field and click on Select to open
the camera. Repeat these steps for each camera you wish to open. Open the camera
that you wish to be the master first.

Note: You may change the name of the camera to aid in differentiation when you are
using multiple cameras. For example, name one camera "Bottom View" and one
camera "Top View." To change the names once the camera is opened, right-click on
the video image and select Change Camera Name.

Camera Information
MiDAS 4.0 can also display pertinent information about a specific camera, as
retrieved from the firmware and camera hardware. To access the information about the
camera, right-click on the camera image and select Camera Information. The camera
manufacturer determines the specific information in the Device Information window.
This information is not editable. Possible information in this window might include:

• Camera serial number

• Camera model number

• Firmware revision level

36 MiDAS 4.0 User Manual



• Camera address

• Maximum frame rate and resolution

• Security code

• FPGA revision level

• Hardware serialization

• Maximum frame rate allowed

Configuring Open Cameras
To configure your camera, click on the Record tab in the control panel. On this tab
you will see controls for your camera frame rate, resolution, and shutter speed.
Based on these user-defined settings, MiDAS 4.0 automatically calculates and
displays the Exposure time, maximum recording time, and Max. Frames. Although
MiDAS 4.0 automatically calculates the maximum number of frames to record, you
can limit this to be any number of frames less than the maximum amount using the
button .

The default frame rate is 60 frames per second. Based on the frame rate chosen,
MiDAS 4.0 will change the resolution to the maximum available. You can then
choose the resolution you desire from the drop-down menu of available resolutions.
The drop-down menu will be limited to only those resolutions that are available.
Lower resolutions will result allow longer recording times and more video frames.
Frame rate is typically the primary consideration, and resolution is adjusted
accordingly. If resolution is the more important factor in your project, some
experimentation will be required to find the combination of resolution and frame rate
that meets your needs.

The shutter speed is the amount of time that the electronic shutter of the camera
remains open during each frame. It is important to note that the electronic shutter is
not a physical shutter, but simply the amount of time that the array is excited and
collecting information. Higher shutter speeds mean shorter exposure times (displayed
below the shutter speed), which reduces blur within each frame at the expense of
light-collecting ability. The default shutter speed is set to 1x. Shutter speeds are the
inverse of the frame rate, times the exposure time. Exposure times are displayed in
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microseconds (10-6 seconds).

Some cameras allow the user to set custom exposure times. To set an exposure time,
select User... from the shutter speed drop-down menu. Then type in the exposure time,
in microseconds, into the dialogue box that appears. Alternatively you may use the
up/down arrows to adjust the exposure time.

For cameras that support the variable setting of recording time and number of frames,
the button to the right of the Max Frames setting will be enabled. Click on this button
to bring up the Frames to Record dialogue box. Use the slider bar or type in the
number of frames to record. Click OK to continue. To reset to the maximum number
of frames permissible by your camera and MiDAS 4.0, drag the slider bar to the far
right.

Record Tab
Frame Rate The frame rate drop-down menu displays

the available video frame rates. The
available rates are determined by the
camera hardware. The default is 60
frames per second (fps).

Resolution The available resolution settings for the
camera. For each frame rate chosen, there
are certain resolutions that are available.
You can choose the desired resolution
from the list shown. Note that lower
resolutions typically result in longer
recording times, so more frames are
captured.

Shutter Speed / Exposure Time The shutter speed is the amount of time
that the electronic shutter of the camera
remains open during each frame. It is
important to note that the electronic
shutter is not a physical shutter, but
simply the amount of time that the array is
excited and collecting information.
Higher shutter speeds mean shorter
exposure times (displayed below the
shutter speed), which reduces blur within
each frame at the expense of
light-collecting ability. The default shutter
speed is set to 1x. Shutter speeds are the
inverse of the frame rate, times the
exposure time. Exposure times are
displayed in microseconds (10-6 seconds).
Select the shutter speed from the
drop-down box. The corresponding
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exposure time will be displayed in the
gray box below the selected shutter speed.
Some cameras allow the user to set
custom exposure times. To set an
exposure time, select User... from the
shutter speed drop-down menu. Then type
in the exposure time, in microseconds,
into the dialogue box that appears,
alternatively you may use the up/down
arrows to adjust the exposure time.

Max Rec Time The maximum amount of time that can be
recorded, in seconds.

Max Frames The maximum number of frames that will
be acquired.

Samples/Frame The Samples/Frame drop-down menu
allows you to choose the number of data
samples that will be acquired per frame of
video.

Data Rate This allows you to adjust the rate at which
data is collected.

Samples / Ch The maximum number of data points that
will be acquired.

Channels Opens a dialog box that will allow you to
configure your data channels.

Trigger Adjust The Trigger adjust allows you to
determine how much pre and post trigger
event will be recorded. The default is
100%, this means that the trigger event
should happen at the end of the event of
interest. A setting of 0% means that the
trigger event should happen at the
begging of the sequence of events.

Pre-Trigger Time The amount of record time to be acquired
prior to the trigger input.

Post-Trigger Time The amount of record time to be acquired
after the trigger input.

Pre-Trigger Frames The number of frames to be acquired
prior to the trigger input.

Post-Trigger Frames The number of frames to be acquired after
the trigger input.
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Trigger Type The Trigger Type box is used to instruct
MiDAS 4.0 as to which type of external
and internal (software button) triggers to
accept. Select Rising Edge if your event
trigger generates a positive going pulse.
Select Falling Edge if your event trigger
generates a negative going pulse. Select
Rising or Falling Edge if your trigger
latches or is a fast pulse. Note: Select
FALLING EDGE when using MiDAS 4.0
Motion Trigger.

LIVE button The LIVE button puts the camera into live
video mode. While in this mode, video is
streamed directly to the display and
refreshed at approximately 5
frames/second, or as configured.

RECORD button The RECORD button puts the camera
board into record mode. MiDAS 4.0
displays a flashing box with the words
MiDAS 4.0 RECORDING to notify the
operator that MiDAS 4.0 is recording.

TRIGGER button The Trigger button sends a software
trigger signal. This button is only
available once the recording has started.

STOP button This button stops the recording and
returns the maximum number of frames
available before the stop button was
pressed. MiDAS 4.0 then goes into the
Play mode.

IDLE button This button stops the recording without
returning any recorded frames, and
without returning the live window, or
switching MiDAS 4.0 to the play mode.

Setting the Camera Active Area
For cameras that support the variable placement and sizing of the active image area,
the button to the right of the resolution setting will be enabled. This feature allows you
to crop the image area to limit the recording to an area of interest. To adjust the active
area click on the Set Active Area button to bring up the Set Active Area dialog
window.
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There are a few ways to modify the active area directly using the mouse controls in the
preview area. You will see a temporary still frame of the active camera surrounded by
a red border. This red border has one box in each corner, and one box in the center of
the active area. You can adjust the active area using these red boxes. To adjust the size
and aspect ratio, click on any of the red corner boxes, which will allow you to re-size
the two adjoining sides. The opposite corner will stay anchored. Once you have
adjusted the size and aspect ratio, you can pan the image by clicking and dragging the
center red box. Moving the centroid will not affect the size or aspect ratio.

You can also adjust the active area utilizing the controls to the right and below the
preview area.

Step Size The settings here will adjust how much the inputs of the other
controls will move the active area. The X and Y coordinates
will adjust the resolution, in pixels, that the centroid of the
active area will move, with each step adjustment. The W and
H effect the step size of the Width and Height steps
respectively. The integer number is fixed based upon the
camera firmware. You can only select those options available
in the drop-down menu.

Move The Move buttons will shift the entire active area, without
affecting its size, in the direction of the arrow. When you
click on a Move arrow, the red border will shift, allowing you
to preview your adjustment geometry. Once you have it
positioned where you desire, click the green button in the
center of the move array to confirm, and the active area will
adjust to the selected area.

Jump The Jump buttons will shift the active area as a whole to the
position represented in the button. The center button will
automatically shift the active area to the center of the pixel
array.

Origin and Size Located below the preview area are 4 text boxes, two for the
X and Y coordinates of the center of the active area, and two
for the width and height dimensions. You can adjust these
values using the arrows to the right of the text boxes. They
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will increase or decrease in increments set in the step size
controls. You can also edit these numbers directly. Click
inside of the box and type the desired coordinate or
dimension. To commit these changes, you will need to click
your mouse into one of the other three boxes.

Refresh The image within the preview area is not a dynamic live
window, but a still frame captured when the active area
button was clicked. As you adjust the active area, this will
not refresh. To show the live image corresponding to the
active area you have selected, click on the refresh button.

Reset This will undo the last active area adjustment you made.

Cancel This will close the Set Active Area window, and you will
loose any adjustments you have made.

Accept This will apply the changes you have made to the active area
and close the Set Active Area dialog box.

Note: When moving the active area away from the center of your camera's field of
view, you may be required to use higher performance and larger format lenses to get
the needed image quality.

Trigger Settings
Once you have finished configuring your camera, you will need to move on to the
trigger settings found on the Record tab on the control panel. In the following
sections, we will go over the trigger settings, trigger types and recording modes
available in MiDAS 4.0.

The Trigger Adjust Setting
The Trigger Adjust setting manages in what way that your video and data will be
collected. You should design your triggering event in such a way that it will be
activated reliably, and be indexed to the action in the same way every time. If you
review the Circular buffer concept you can understand why it is so important to
properly design and configure your triggering plan. The camera will be constantly
writing to the buffer from the time that recording begins, using the principal of first in
first out. You have a finite amount of frames to utilize, so to get the data you require,
you must make sure that you trigger during the period of interest.

The number reported in the button to the right of the slider bar is the pre-trigger
percentage of the total acquisition. The reporting boxes below will tell you how much
time, and how many frames will be collected pre and post trigger.

42 MiDAS 4.0 User Manual



Trigger Types
In addition to the internal (software) trigger generated by clicking on the Trigger
button in the Record Tab, MiDAS 4.0 accepts three different types of basic hardware
triggers, also known as external event triggers. The types of triggers, the input voltage
ranges, the triggering thresholds, and the connection types are determined by your
camera architecture. In addition, many cameras allow a contact closure to be
interpreted as a trigger event. Consult your camera manual to determine which trigger
types and input types are available.

If your camera does not support a certain trigger type, that option is grayed on the
menu.

You may specify the type of trigger by selecting one of the following options from the
drop-down list in the Record tab on the control panel:

Rising Edge Select Rising Edge if your event trigger generates a
positive-going pulse, or if your camera hardware interprets
a contact closure as a trigger event.

Falling Edge Select Falling Edge if your event trigger generates a
negative-going pulse.

Rising or Falling Select Rising or Falling if you wish to trigger upon either
type. If you have a latching trigger, a flip-flop or logic
device that sends out a pulse, use this option.

Note: Select Falling Edge when using the MiDAS Motion Trigger.

Connecting an External Event Trigger
To trigger MiDAS 4.0 using an external trigger pulse from a sensor or machine output,
you must first connect that sensor to a physical MiDAS 4.0 component. You must
always connect the event trigger to the first component on the synchronization chain.

The location of the master component depends on what combination of MiDAS 4.0
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modules you have installed and determines where you should connect your external
trigger.

Note: When chaining multiple cameras together, make sure to connect the external
trigger to the Trigger In connector on the first camera in the chain.

The easiest method of determining where to connect your external trigger is to use the
MiDAS 4.0 Connection Assistant. The Connection Assistant, in addition to helping
you confirm the cabling and interconnection between multiple cameras, data
acquisition systems and external timing boards, also explains where to connect the
external trigger input.

The MiDAS 4.0 Hardware Connection Assistant can be opened from the Tools menu.

Depending on what hardware is installed and enabled, the Connection Assistant will
show the interconnection diagram.

Note: Consult with your camera manufacturer to find the input trigger location and
labeling. Camera manufacturers often change label conventions.

WARNING: Do not connect your event trigger to more than one location. Doing so
will confuse the clocks and could effect your measurement. Connect the event trigger
to one location only.

Controlling the Recording Process
The final step in making a recording, after you have configured your device and
trigger settings, and entered into recording mode is to trigger the recording.

While MiDAS 4.0 is in Record mode, the Record Tab is your primary means of
controlling the recording process. On the Record Tab you will find the following
buttons:

Live sets the camera view window to a live display of the images in the
camera buffer. The camera view window displays frames at a default rate
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of 5 frames per second. (This default can be changed under the HG tab in
the Edit -> Record Options menu.)

Record This button puts the camera into recording mode. While recording, video
(and data, if applicable) is being written to the buffer. If live video and
data acquisition while recording are supported and enabled, the camera
pane and data pane will continue to display live images. (These options
may be enabled in the Record tab from the Edit -> Record Options
menu).

Trigger This button sends a software trigger signal (if being used) to MiDAS 4.0.
The Trigger button is only available once the recording has started. In
other words, you must click the Record button before the Trigger button.

Stop This button stops the recording. See Chapter 8, Event Triggering for an
explanation of the Stop command.

Idle This button stops the recording without capturing video or data from the
buffer and without switching MiDAS into Play mode.

Once you have clicked on the Trigger button and MiDAS 4.0 has carried out the
recording process according to the camera and trigger settings, the program will
automatically switch into Play mode.
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Chapter 5. Video Trigger
The MiDAS 4.0 video trigger offers the user the ability to trigger recordings from
action within the video frame. This allows you to trigger video and data when the
action has actually entered the video frame. Movement is sensed by a change of pixel
intensity within a user selected region of the video frame. The video trigger does not
control the cicular buffer. The Trigger Adjust settings in the Record tab will still
control the percentage of pre and post video/data capture. The Video Trigger only
identifies the trigger event.

Configuring the Video Trigger
To configure the video trigger you must have a live camera window open. Once you
have opened a camera as described in Chapter 4, Recording Projects switch to the
Video Trigger tab. You can then select a region for the video trigger, then set the
thresholds.

1. Click on the Define Region button within the Video Trigger tab.

2. The reticle will be enabled. Use this to choose the region that you wish to use for
the Video Trigger.

3. Once you have outlined the area you want,click on the Set Region button.

4. Once you have selected a Region, an intensity graph will open. Based upon the
settings currently chosen it will sample the intensity of the specified amount of
frames in the Training Count field.

5. Once the number of frames in the Training Count field are sampled MiDAS 4.0
will calculate the average intensity, and determine and display two threshold
levels based on the Rising Level and Falling Level settings.



The red and green threshold levels display the pixel intensity values that will initiate a
trigger. Once the camera is put into record mode, it will monitor the region you have
selected. When the intensity levels exceed the threshold values you have chosen to use
in the graph, MiDAS 4.0 will send a trigger pulse. You can adjust the threshold levels
with the Rising Level and Falling Level drop down selections.

It is important to note that the average baseline of the Video Trigger can be any level
of pixel intensity from 0 to 255. Since the trigger thresholds are relative to the
baseline, it is possible that you could achieve Trigger threshold levels that are less
than 0 or greater than 255. Tthe camera cannot generate values of this level. Therefore
any trigger levels that are less than 0 or greater than 255 will not work. If your
baseline is closest to 255 (white) you should concentrate on the Falling Level
threshold. If your baseline averages are closer to 0 (black) you should concentrate on
Rising level threshold.

Adjusting the Video Trigger
The average baseline can be noisy depending on local lighting conditions. If there is a
noisy signal, the default threshold levels of +10 and -10 pixels may not work for your
application. The MiDAS 4.0 Video Trigger allows for adjustment if these thresholds.
In addition it allows for you to use the first frames in record mode as the training
period for the Video Trigger.

48 MiDAS 4.0 User Manual



The first selection under Settings controls the Rising Level trigger. There is a
checkbox that enables the Rising Level trigger. Use this if you expect the change to be
towards more white levels, i.e., approaching 255. If you do not want to trigger on
higher white values, un-check this box. The drop down box allows you to set the
threshold that will activate the trigger. This number is in levels of pixel intensity.
There are preset values, but you can also choose User which will allow you to input
the number you require.

The second Checkbox controls the Falling Level thresholds. It works similarly to the
Rising Level threshold controls, but in the change to Black (0) direction of the video.

The final setting is the Training Count. This is the number of frames sampled to
establish the baseline average that the threshold levels are referenced to. If the light
levels in the region you wish to use as a trigger are noisy, you will want to expand the
number of frames used for training.

Some cameras will have changes in the image when switching to record mode. For
this reason MiDAS 4.0 has the ability to establish the training period from when the
Camera enters record mode. This is enabled by checking the box labeled Train on
Record. When enabled it will sample the number of frames in the Training Count
field, establish an average for the baseline, and then apply the thresholds as you have
configured them in the Rising Level and Falling level fields.

As you make changes you can re-establish the graph baseline by clicking on the
Re-train button.

Once the pixel intensity in the region you have established as the video trigger exceeds
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the threshold values, MiDAS 4.0 will send a trigger as configured in the Trigger
Adjust in the Record Tab.

50 MiDAS 4.0 User Manual



 
 
 

Automation 

Chapter 

6 



 



Chapter 6. Automation
Overview

The MiDAS 4.0 Automation feature allows for the unsupervised, automated collection
of video and data. MiDAS 4.0 offers a variety of Automation modes to satisfy your
requirements for automated data collection. With the exception of the Time Lapse
feature, all Automation modes collect video and data as configured in the Record tab.

Automation Modes
Each automation mode has different methods of triggering and collecting recordings.
Below is a detailed description of each automation mode.

Basic Basic mode is a Record-Download-Reset



cycle. MiDAS 4.0 will enter Record mode
and wait to receive a trigger. Once a
trigger is received, it will download the
recording as configured in the Record tab.
Once the recording is saved, MiDAS 4.0
will return to Record mode. This process
will continue until you exit Automation
mode or until the Reset Count is reached.

Timed Reset Time Reset mode is a
Record-Download-Delay-Reset cycle.
MiDAS 4.0 will enter Record mode and
wait to receive a trigger. Once a trigger is
received, it will download the recording
as configured in the Record tab. Once the
recording is saved, MiDAS 4.0 will enter
Idle mode for the amount of time
specified in the Delay Reset field. MiDAS
4.0 will then return to Record mode. This
process will continue until you exit
Automation mode or until the Reset
Count is reached.

Auditing Auditing mode is a
Record-Download-Delay-Reset-Delay
cycle. MiDAS 4.0 will enter Record mode
and wait to receive an AutoTrigger. The
AutoTrigger will occur at a time interval
specified by the user in the Delay
AutoTrigger field. Once a trigger is
received, it will download the recording
as configured in the Record tab. Once the
recording is saved, MiDAS 4.0 will enter
Idle mode for the amount of time
specified in the Delay Reset field. MiDAS
4.0 will then return to Record mode. This
process will continue until you exit
Automation mode or until the Reset
Count is reached.

Time Lapse Time Lapse mode is a Record-Download
cycle. MiDAS 4.0 will enter Record mode
and wait to receive a trigger. Once a
trigger is received, it will download the
recording as configured in the Record tab.
Once the recording is saved, MiDAS 4.0
will enter Idle mode for the amount of
time specified in the Delay Reset field.
MiDAS 4.0 will then return to Record
mode. This process will continue until
you exit Automation mode or until the
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Reset Count is reached. The downloaded
recordings are stiched together to form
one larger video.

Maximum Download Maximum Download is a
Record-Download cycle. MiDAS 4.0 will
enter Record mode and wait to receive a
trigger. Once a trigger is received, it will
download the recording as configured in
the Record tab. Once the recording is
saved, MiDAS 4.0 will return to Record
mode. This process will continue until
your computer runs out of memory or
until the Reset Count is reached.

Custom The Custom option will enable all fields
and allow you to configure the recording
process as desired.

Below is a quick reference document to assist in configuring Automation. For
recording parameters refer to Chapter 4, Recording Projects.
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Reset Count Settings
The Reset Count Settings control the number of times that the recording cycles will
repeat in the selected Automation mode.

Infinite Reset Selecting Infinite Reset enables the automation mode to
continue indefinitely until the user manually stops the
recording.

Reset When the Reset selection is enabled, you will be able to input
an integer into the accompanying field to specify the number
of recordings.

Naming Utilising this field will allow you to alter the number appended
to each file name. For example, if you enter "25" in this field,
the first saved file will be named filename25. The number
is incremented for each consecutively saved file.

Name, Location, and Range
The Name, Location, and Range section is utilized to define the naming convention
and location for downloaded files.

The Name, Location, and Range section simply reports the filename and extension
being used, as well as the frame range to be saved and the final location of the
downloaded files. To change these settings, click the Edit button, which will open an
additional dialog box where the settings can be changed.
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Base Filename This is the leading potion of the filename that will
be used for every sequence saved. A number is
appended to the Base Filename when a file is saved.
The starting number is defined in the Naming field
under Reset Count Settings. The number is
incremented for each consecutively saved file.

Destination Folder(s) This will allow you to choose the destination where
recordings will be saved. You can populate this field
with multiple locations. Clicking on Add will open a
file browsing window. Once a destination is
selected, it will be placed within Destination
Folder(s) field. Files downloaded in Automation
mode will be saved to the first location in the list
until the drive is full, or until the size limit for the
folder has been reached. Files will then be saved in
the next location listed.

Frame Range This allows you to select what range of frames
captured will be saved to the video and/or data file.
Checking the All box will save the complete set of
frames. When the Range box is checked you will be
able to select the range of files to be saved. Note that
negative frame numbers occur before the trigger,
identified as Frame 0, and positive numbers occur
after the trigger.
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Format The Format section determines which type of file
videos will be saved as. To change click on the
Edit... button, a separate dialog will open. The
choices you have are either .avi, or image
sequences .jpg, .bmp, .tif. Once selected, click
on OK to save your changes, or Cancel to leave the
dialog without making any changes.

Automation Controller
Once you have configured the automation settings and your hardware is in place, you
can activate the Automation Mode. Click the Activate button at the bottom of the
Automation tab. This will open the Automation Controller dialog box.

This controller will allow you to engage and stop the automation mode.

Automation This section will display which mode of Automation you are in,
and contains the Engage Auto-Download button. Once engaged,
Automation will start to record based upon how you have
configured Automation. The Engage Auto-Download Button
will revert to the Disengage Auto-Download button . Use this to
stop the automated collection of recordings.
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Idle The Idle section includes two buttons, Idle / Live and Idle / No
Live. This will pause the Automation mode without exiting. Idle
/ Live will pause the recording and will allow you to view a live
camera window. Idle / No Live will pause without displaying a
live camera window. To re-engage Automation, click on the
Disengage Auto-Download button, and then Engage
Auto-Download.

Test Triggers Here we have two buttons in this section for manually triggering
or stopping the current recording. The Test Trigger button will
send a trigger pulse to MiDAS 4.0 and the camera, and a
recording based upon your trigger configuration will be
captured. This recording will also be saved per your
configuration. The Panic Stop Button will act as a trigger with a
100% pre-trigger. It will trigger and stop recording immediately,
saving all previously captured video and data, then return to
Record Mode. To exit Automation and Record modes, click the
Disengage Auto-Download button.

Settings This is simply a reporting window that displays all of the
settings as you have configured them. At the bottom is the Last
Save Location field, which will display the last save location
utilized.
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Chapter 7. Data Acquisition
Theory
Overview

If you have purchased MiDAS 4.0 Full Edition, you can capture data from a variety of
sensors, including accelerometers, strain sensors, microphones, etc. and have them
integrated with your video into a MiDAS 4.0 project. MiDAS 4.0 will accept up to
sixty-four (64) analog inputs. You can also use these as triggering sources for your
video capture needs.

There are eight available high-speed Data Acquisition kits for MiDAS 4.0. The
specifications of these kits are as follows:

Part Number Differential
Analog Inputs

Single Ended
Analog Inputs

Total Sample
Rate (kS/s)

Included
Hardware

DA-123M 8 16 200 BNC Breakout
Box / PCI card

DA-124M 8 16 200 BNC Breakout
Box / PCMCIA
card

DA-162M 8 16 500 BNC Breakout
Box / PCMCIA
card

DA-170M 8 16 1,250 BNC Breakout
Box / PCI card

DA-171M 16 64 1,250 BNC Breakout
Box & BNC
Extended
Breakout Box /
PCI card

MiDAS 4.0 Data Acquisition models DA-123M, -170M and -171M are all configured
for PCI bus architecture with 12-bit resolution. Output lines and digital input lines are
currently not used by MiDAS 4.0 standard software but are available for use with
specialty software and with the DAQ boards independent of MiDAS 4.0.

All MiDAS 4.0 data acquisition kits are supplied with a data acquisition board
manufactured by National Instruments, a cable and a breakout box. The supported
configurations of data acquisition hardware are shown in the following diagram:



Installation instructions are provided in Chapter 2, Installing MiDAS 4.0.

How MiDAS 4.0 Data Acquisition Works
The Master Clock
The master clock used by the MiDAS 4.0 data acquisition system comes from the data
acquisition board installed in the computer. The data acquisition board sends pulses to
both the data acquisition engine and the video acquisition engine of MiDAS 4.0 with
precise timing. Each timing pulse causes the acquisition of the corresponding signal
and the subsequent storage of the data or video. The MiDAS 4.0 data acquisition
board and the camera board are connected via a synchronization cable - a BNC coaxial
cable from the Phase Out connection on the BNC breakout box to the Phase In
connection on the camera board. The camera operates as a slave device to the MiDAS
4.0 system - that is, a frame is acquired when a pulse is received across the phase in
line. Similarly, the MiDAS 4.0 data acquisition engine is a slave device to the system:
data is acquired only when the software instructs the engine to sample each enabled
analog input channel.

The ability to have synchronized yet different clock rates, and thus a different
acquisition frequency for video and data is the basis for the MiDAS 4.0 Waveform per
Frame™ technology. If, for example, the operator chooses to acquire 10 data points
per single frame, the pulse sequence includes one pulse to the video camera for every
10 data pulses, as follows:
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Multiplexed Data Acquisition
If multiple analog channels are selected, the various inputs are multiplexed - sampled
sequentially through a single analog input. The input is switched between the enabled
channels. The switching time between acquisition is dependent on the type of data
acquisition card you are using. If your data acquisition hardware can acquire 200,000
samples per second (e.g. model DA-123M), and if you enable two (2) analog input
channels, then each channel can acquire 100,000 samples/second. If four (4) channels
are enabled, then each channel can acquire 50,000 samples/second. If eight (8)
channels are enabled, then each channel can acquire 25,000 samples/second.

Therefore, if in the above example, the operator chooses to acquire 10 data points per
frame and enables 8 analog channels, the pulse sequence includes one pulse to the
video camera, and 10 slightly offset data pulses to each data channel.

Camera images are streamed directly to the local memory on the camera board. Data is
streamed directly to the computer RAM.

BNC Breakout Box vs. Terminal Block
vs. 5B+ Rack

Most MiDAS 4.0 data acquisition kits include a standard BNC breakout box. If you
purchased an extended analog model (DA-171M), you also received an additional
BNC extension breakout box.

MiDAS 4.0 is also capable of working with a 5B+ rack system.The 5B+ rack is a
common hardware interface from Analog Devices Inc, that allows for individual
signal conditioner hardwares. MiDAS 4.0 accepts standard outputs from 5B+ signal
conditioner hardwares.

Some high-end and laboratory applications necessitate replacing the BNC breakout
boxes with optional screw terminal blocks. It is recommended that you be very
familiar with data acquisition fundamentals and with your sensor performance if you
are to use terminal blocks. Terminal blocks are typically used for a large number of
sensor inputs (MiDAS 4.0 can support 64 sensor inputs) and for large numbers of
single-ended sensors that bring only one wire back to the data acquisition hardware.

The following table helps describe the advantages of each type of connection
hardware. If you have questions for a particular application, contact Xcitex engineers
for assistance.
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BNC breakout
box(es)

Terminal block(s) 5B+ rack

Maximum number
of analog inputs
kits: DA-123M,
DA-124M,
DA-162M,
DA-170M

8 any type 16 Single Ended or
8 Differential

16 any type

Maximum number
of analog inputs
kits: DA-171M

8 any type 32 any type Not Available

Maximum number
of extended inputs
kits: DA-171M

24 any type 32 any type Not Available

Cable type Shielded Shielded Ribbon

Switching Internal None Internal

Connection types BNC jacks Screw terminals Plug ins

Internal
isolation/shielding

Yes No No

Built-in bias
resistors for
floating sources

Yes No Yes

Accepts signal
conditioner
hardwares

No No Yes

Powers strain
gauge sensors
directly

No No Yes

Accepts Voltages
greater than
+/-10V

No No Yes (with SC)

Accepts
single-ended signal
inputs

Yes Yes Yes

Accepts
differential signal
inputs

Yes Yes No
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BNC pigtail
required for sync
cable

No Yes No

BNC pigtail
required for ext.
trigger

No Yes No

Connecting Your Data Acquisition
Hardware

Please refer to Chapter 2, Installing MiDAS 4.0 to install the software and hardware
for the data acquisition hardware.

If you are using a BNC breakout box, connect your synchronization cable(s) between
the breakout box and the camera. The system should resemble the following diagram:

Note: It is advisable to first install MiDAS 4.0 with the standard BNC breakout
box(es) supplied with your shipment. Once you have tested and learned how to use
MiDAS 4.0 with the standard hardware, change over to the optional 5B+ rack or
terminal block as required by your application.

Note: MiDAS 4.0 no longer supports MiDAS 1.X style breakout boxes.

If you are using Terminal Block(s), simply disconnect the standard BNC Breakout
Boxes and replace them with the optional Terminal Blocks. On the primary Terminal
Block (the one connected to the cable labeled "MIO-16"), you must also:

• Connect (with a wire) terminal 10 to terminal 40

• You must also create the Sync Out synchronization cable. Using a BNC pigtail as
such as shown:
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• Connect the red (center post) wire to terminal 2

• Connect the black (outside ground) wire to terminal 35

• Label this pigtail "Sync Out." From this connector, run the BNC sync cable to
the camera "Sync-In" connector as shown in the above diagram

• You must also create a BNC connector to accept the external event trigger. Using a
BNC pigtail as shown in the figure above.

• Connect the red (center post) wire to terminal 41

• Connect the black (outside ground) wire to terminal 3

• Label this pigtail "Trigger In."

• When you configure your sensors make sure you select CB/SCB Terminal
Block(s)

If you are using a MiDAS 5B+ rack, simply connect the 5B+ ribbon cable and the 5B+
rack directly to the data acquisition board as instructed in Chapter 2, Installing MiDAS
4.0 of this manual. No jumpers are required for 5B+ hardware. The sync cable and the
external trigger connect directly to the extension bracket on the 5B+ rack.

64 MiDAS 4.0 User Manual



MiDAS 4.0 software typically recognizes that your system is set up to acquire
synchronized data. You can enable or disable data acquisition by selecting or
de-selecting the "Synchronized Recording" checkbox in the RECORD OPTIONS
window under the EDIT menu. See Chapter 3, Fundamentals for more information
about the RECORD OPTIONS window.

Note that the process of updating a live data graph is very processor intensive and can
require all of the processor power available from the computer, leaving no
computation ability for other MiDAS 4.0 functions. For example, you may not be able
to stop the recording or re-size a window, If your computer has a slower processor,
uncheck the Live data graphing while recording checkbox in the RECORD OPTIONS
window under the EDIT menu. If you do not do this, the system may be slow to
respond, and there may be other unfavorable effects.

Note: Enable the Live data graphing while recording feature only if you have
sufficient CPU power. To determine if your computer has enough power, enable the
CPU monitor from the Performance tab of the Windows Task Manager during a test
recording and note the amount of CPU usage during a recording. Optimally, the CPU
usage should be <40%.

Under the Data tab of the RECORD OPTIONS you can control how much of system
memory is used to store sensor data. With systems with large amounts of RAM
memory it is often beneficial to reduce this from the default from 10 percent.
Otherwise the amount of sensor data can be so large as to be difficult to manage.
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Data Acquisition Basics
MiDAS 4.0 data acquisition kits have been designed to work with a large number of
different types of transducers.These sensors convert force, rate of flow, pressure,
temperature, etc. into a voltage that is proportional to the physical parameters being
monitored. Typical sensors include:

• Accelerometers

• Microphones

• Strain Gauges

• Flow Sensors

• Pressure Sensors

• Thermistors

• Hydrophones

• Dynamometers

• Speedometers

• Tachometers

Often, signals from these sensors must be amplified, filtered, biased, converted from
current to voltage, or other similar processes. Therefore, each sensor type typically
uses a signal conditioner, designed for the type of sensor, to produce signals
recognized by the MiDAS 4.0 data acquisition hardware. MiDAS 4.0 utilizes varying
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voltage for its data recording needs; therefore any signal conditioner that outputs a
voltage can be utilized.

Understanding What MiDAS 4.0 Data
Acquisition Measures
In the next few sections, you will be introduced to the variety of sensor types most
commonly used with MiDAS 4.0. However, it is first important to understand what the
various data acquisition kits measure.

Your MiDAS 4.0 data acquisition board has an on-board instrumentation amplifier.
Sensors are connected to the DAQ hardware (breakout box or terminal block), which
in turn passes these signals to this amplifier via the cable and board connector.
Therefore, when you connect your sensor to the MiDAS 4.0 hardware, you are
essentially connecting directly to the computer board circuitry.

MiDAS 4.0 measures the difference between the output of the instrumentation
amplifier and another reference voltage. Based on the information you give MiDAS
4.0 when setting up your test, the software measures the difference between the
amplifier output and a ground, either the computer ground, the local ground at your
sensor or signal conditioner, or a floating ground source.

An instrumentation amplifier is a differential amplifier, It outputs the difference
between two inputs. Therefore two leads from a sensor can be connected to the
amplifier, the amplifier will then compare the inputs and reference them to the chosen
ground.

The differential instrumentation amplifier on the MiDAS 4.0 data acquisition board is
depicted as follows:

The signal inputs are connected to the sensor or to the transducer via the end connector
on the board or via the BNC breakout box provided with all MiDAS 4.0 data
acquisition systems.

Understanding Different Types of Sensors
Sensors have different characteristics that must be considered when connecting to
MiDAS 4.0 or any data acquisition system.
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Some sensors have two output wires and produce a signal that is the difference
between the positive (+, or signal) lead and the negative (-) lead. These are known as
"differential" sensors.

Some sensors have one signal wire and one common wire. These sensors are generally
named "single-ended" sensors. Typically, the common wires for an entire group of
single-ended sensors are all tied together. These are very common in larger test
facilities that use many sensors (crash testing, structural testing, etc.)

If the common wire from a sensor is physically connected to the data acquisition
hardware, the system is called "referenced" - that is, the sensor common is electrically
connected to the data acquisition board common. On the other hand, if the common
wire from a sensor is connected to a common building or earth ground (and perhaps
not physically connected to the data acquisition (hardware), the system is considered
to be "non-referenced."

Sensors may also be configured as combinations of these types, such as referenced
single-ended, non-referenced single-ended, or differential.

MiDAS 4.0 is designed to work with all of these sensor designs. The operator must
simply instruct MiDAS 4.0 as to which sensor type is being connected, and the
software automatically makes the proper adjustments and switch settings. For
example, if you are using a Referenced Single Ended sensor, MiDAS 4.0 knows to
reference the signal to the common ground of the system (e.g. computer or building)
and makes the appropriate internal switch changes. Likewise, if you are using
differential sensors, MiDAS 4.0 knows which terminals to assign to the sensor and
makes the appropriate switch changes to measure the difference between positive and
negative leads.

Differential sensors are always recommended for better signal integrity. Single-ended
sensors are recommended only under controlled conditions. If your signal environment
is the least bit noisy, your cable lengths exceed 3 meters (10 ft) or your signal level is
less than 1V P-P, then it is highly recommended that you use Differential sensor types
with two leads.
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In the following sections, each type of sensor is summarized and depicted with a basic
schematic.

Differential Grounded Sensors
In this configuration, the Differential sensor has two leads-one positive (+) and one
negative (-). The negative lead of the sensor is also tied to earth or building ground
and is therefore already connected to a common ground point with respect to the board
(assuming that the computer is plugged into the same power system).

If you have a differential grounded sensor and you are using either a BNC breakout
box or a terminal block, wire the sensor positive and negative leads directly to the
DAQ hardware, as shown in the following diagram.

Most commercial data acquisition systems are designed in a differential grounded
configuration, especially if significant signal conditioning is required. In this
configuration, the little rocker switch under the BNC jack should be placed in the
"GS" position.

Differential Floating Sensors
In this configuration, the differential sensor has two leads-one positive (+) and one
negative (-) where the negative lead of the sensor is NOT tied to earth or building
ground and is therefore "floating" with respect to the amplifier. Therefore, to reduce
the effects of signal drift relative to the board ground, you must tie the ground
reference of the floating signal to your board's analog input ground through a bias
resistor.

If you are using a BNC breakout box, a built-in 5kW bias resistor (and 0.1 mF
capacitor filter) is automatically engaged when the rocker switch below the BNC jack
is set to "FS".

If you are using a terminal block, you must add the bias resistor yourself. For sources
with low impedance, no bias resistor is needed and you may simply connect the
negative lead to AIGND as well as the assigned screw terminal for the negative side of
the amplifier. For sources with high impedance, however, you must put a bias resistor
in-line to de-couple the noise from the amplifier. Place a bias resistor of minimum
100x the equivalent source impedance between the negative terminal and the AIGND
pin as shown in the following diagram:
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Some commercial data acquisition systems require an in-line resistor due to larger
source impedance. Check the manual provided with your sensor for their
recommendation. In this configuration, the rocker switch under the BNC jack should
be placed in the "FS" position.

Single-Ended Grounded Sensors
(Non-Referenced or NRSE)
Single-ended sensors have one wire that carries the signal (+) and one common wire.
Typically, single ended sensors are used in specialized applications such as crash
testing where many additional sensors are required and the test environment is highly
controlled. If you are using single-ended sensors, you may tie the common wires of
the sensors together.

On a grounded single-ended sensor, the common lead of the sensor is also tied to earth
or building ground and as such is already connected to a common ground point with
respect to the board (assuming that the computer is plugged into the same power
circuit). However, since the differential amplifier needs both a positive (+) and
negative (-) input, the common lead must be tied to a point on the DAQ hardware
called the AISENSE - an internal ground sensing point. When using single-ended
grounded sensors, the common lead gets tied to AISENSE at the BNC breakout box
or the terminal block hardware. All other connections and switches are handled
automatically by the MiDAS 4.0 software.

If you are using a BNC breakout box, the positive signal lead is connected to the
center post of the BNC jack and the common lead(s) must be wired to the AISENSE
terminal screw on the breakout box, as depicted in the following diagram:

If you are using a terminal block, the connections are identical. The positive signal
lead from the sensor gets connected to the appropriate screw terminal and the common
lead(s) must be wired to the AISENSE terminal as depicted in the following diagram:
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In the NRSE (single-ended grounded) mode, the MiDAS 4.0 software measures the
difference between the output of the amplifier and AISENSE, The switch on the BNC
breakout box is not used.

Single-Ended Floating Sensors (Referenced
or RSE)
Single-ended sensors have one wire that carries the signal (+) and one common wire.
Typically, single ended sensors are used in specialized applications such as crash
testing where many additional sensors are required and the test environment is highly
controlled. If you are using single ended sensors, you may tie the common wires of the
sensors together.

On a floating single-ended sensor, the common lead of the sensor is not tied to earth or
building ground and as such is floating relative to the ground of the amplifier.
Therefore, to reduce the effects of signal drift relative to the board ground, you must
reference the floating signal to the amplifier analog input ground through a bias
resistor.

You must add the bias resistor yourself, even if you are using the BNC breakout box
(single-ended sensors do not use the negative lead of the BNC jack). For sources with
low impedance, no bias resistor is needed and you may simply connect the common
lead(s) to AIGND directly. For sources with high impedance, however, you must put a
bias resistor in-line to de-couple the noise from the amplifier. Place a bias resistor of
minimum 100x the equivalent source impedance between the negative terminal
(common) of the sensor and the AIGND pin of either the BNC breakout box or the
terminal block (whichever you are using) as shown in the following diagram:

Note that this resistor must be placed regardless of whether you use the BNC breakout
box or the terminal block. In the RSE (single-ended floating) mode, MiDAS 4.0
measures the difference between the output of the amplifier and AIGND. The switch
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on the BNC breakout box is not used.

How Multiplexing Works
MiDAS 4.0 data acquisition kits gather their signals through multiplexing, the
common technique for sampling multiple channels with one acquisition device. The
incoming signals are wired to a multiplexer switch (mux) that rapidly, switches the
inputs to the instrumentation amplifier. The MiDAS 4.0 software automatically
configures the data acquisition hardware to enable this switching and keeps track of
which channel is configured on which connector.

When a single acquisition device deals with a multiplexed input, the incoming signals
are staggered. For example, first channel 0 is sampled, then channel 1, then channel 2,
etc. The increment of time between samples is inversely proportional to the number of
channels and the total sample rate, but is typically a few microseconds.

Therefore, if multiple channels are selected, the true diagrams presented in the
previous section would also include the front multiplex switch, as follows (example of
differential grounded source):

Note: This is a schematic for demonstration purposes. The switches are not
mechanical, but high-speed semiconductor switches.

Choosing the Data Sample Rate
Since the inputs are switched via the multiplexer described above, the total data
sample rate is the product of the number of channels times the sample rate per
channel. For example, if you have 4 channels active and wish to acquire 10,000
samples per second per channel, the total sample rate is 4 x 10,000 = 40,000
samples/second. Likewise, if your data acquisition board is rated for 200,000 samples
per second maximum rate and you have 8 channels active, the maximum rate per
channel is 200,000/8 = 12,500 samples/second.

One important consideration when selecting the data rate is the processor usage.
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MiDAS 4.0 draws each data point on the screen plus the cursor position for each
graph. With many thousands of data points and multiple channels, the processor power
required just to draw continuously will slow the system performance.

Opening and Configuring Data Card(s)
Begin by opening a new Record project if you do not already have one open, either by
selecting New Group from the File menu or by clicking on the New Play Group
icon in the program window toolbar. It's important to note that you can only have one
Record Group open at a time.

Connect your data acquisition hardware per the instructions in Chapter 2, Installing
MiDAS 4.0. If you have multiple data cards in your system, interconnect the hardware
as depicted in the MiDAS 4.0 Connection Assistant.

Under File... Click on Open Data Card.... A dialogue box will appear prompting you
to select the hardware family of your data acquisition card.

Select the appropriate family and click on Scan. If your hardware is properly
connected and configured, it will appear in the Available Devices field.

Select the desired camera from the Available devices field and click on Select to open
the Data acquisition card. Repeat these steps for each card you wish to open.
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Connecting Sensors to the BNC
Breakout Box

1. Click on the wrench button located next to channels next to the Data section in
the Recording tab. The DATA ACQUISITION SETTINGS dialog box will open.

2. Select BNC BREAKOUT BOX(ES) in the DAQ Configuration window.

3. Select the appropriate channel (e.g. "Channel 0") from the drag-down box. If that
channel is available, click the ON checkbox. If that channel is unavailable, go to
the next highest channel until you find an available channel. Always start with
Channel 0.

4. Determine the type of sensor that you are using (see the instruction manual that
came with your sensor for more details).

5. Determine the parameters of the sensor (gain, offset, voltage range, calibration).
Make sure you factor in the signal conditioning amplification, if appropriate.

6. Configure MiDAS 4.0 with the specific information about the sensor and (if
applicable) signal conditioner. Set the information about each sensor on which
you are acquiring data. The following chart shows the options for configuring a
sensor. Enter all the information requested.

DAQ hardware being used The options are BNC Breakout Box(es) or
Terminal Block. If you are using the
supplied BNC Breakout Boxes, select BNC
BREAKOUT BOX(ES) See above.

Channel MiDAS 4.0 automatically determines and
displays which channels are available based
on which DAQ hardware you have installed
and which type of sensors you have already
configured. Start with the next sequentially
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available channel and check the box to
enable that channel.

Input Mode The three options here are DIFF, RSE and
NRSE. See the above description to
determine which type of sensor you are
using. If you do not know which type of
sensor you have, and the sensor was
provided with a BNC connector, try DIFF
mode.

Label Provides a short (4 character) label for the
analog input channel. This label is printed
on the melded AVI file. We recommend
using lower case letters only.

Units A short (3 character) field for placing units
in the graphs. We recommend using lower
case letters only.

Lower Limit The lower limit, in volts, that you expect to
see from your sensor. MiDAS 4.0 magnifies
the dynamic range of the input from Lower
Limit to Upper Limit. Voltages that exceed
the lower limit in this field will appear as
clipped or under-saturated. A small amount
of over scan has been automatically
provided. Typical "bi-polar" sensors have an
input range of -10V to +10V Typical
uni-polar sources have an input range of 0V
to +10V.

Upper Limit The upper limit, in volts, that you expect to
see from your sensor. MiDAS 4.0 magnifies
the dynamic range of the input from Lower
Limit to Upper Limit. Voltages that exceed
the upper limit in this field will appear as
clipped or saturated. A small amount of over
scan has been automatically provided.
Typical "bi-polar" sensors have an input
range of -10V to +10V Typical uni-polar
sources have an input range of 0V to +10V.

Factor The scale factor to be applied by MiDAS 4.0
to convert the input volts to a meaningful
number, in engineering units. This number is
applied immediately after the input voltage
is registered.
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Offset The offset to be applied by MiDAS 4.0 to
account for drifts or offsets in the input, in
units. This offset is applied after the scale
factor multiplication.

PLOT COLOR button The color of the line to be used in
multiple-line graphs. Select this button to
bring up the color palette.

UPDATE button When clicked, this button causes the table to
be updated with the new information.

SET AS DEFAULT button When clicked, this button causes the current
data configuration to be saved as the default
for all future measurements. When the
MiDAS 4.0 data acquisition section is
opened subsequently, the default
configuration will be present.

OK button Exits the screen without further data saving.

7. Click on the UPDATE button.

8. Physically connect your sensor to the BNC Breakout Box(es).

• Terminate your sensor with a BNC plug connector. Connect the positive
signal channel (+) from your sensor to the center post of the BNC.

• If you are using a differential sensor, connect the negative to the outside
of the BNC. Note that most differential sensors will already have BNC
terminations.

• If your sensor is a single-ended grounded (NRSE) sensor, connect the
common wire from the sensor system to the screw terminal labeled
AISENSE on the BNC Breakout Box.

• If your sensor is single-ended floating (RSE) sensor, connect the common
wire from the sensor system to the screw terminal labeled AIGND on the
BNC Breakout Box with a bias resistor, as described in the above section.

• Connect the BNC connector to the corresponding BNC input on the BNC
Breakout Box and the BNC Extended Breakout Box. MiDAS 4.0 will
automatically enable the correct channels for you depending on which data
acquisition hardware is installed. Data acquisition models DA-123M,
DA-162M and DA-170M, all enable 8 channels. Data acquisition models DA
-171 enables 32 channels.

When using the MiDAS 4.0 BNC Breakout Box(es), connect your sensors as
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shown in the following chart:

MiDAS Channel (as selected in Settings
Window)

Connect Sensor to BNC labeled...

0 ACH 0

1 ACH 1

2 ACH 2

3 ACH 3

4 ACH 4

5 ACH 5

6 ACH 6

7 ACH 7

16 CH 16

17 CH 17

18 CH 18

19 CH 19

20 CH 20

21 CH 21

22 CH 22

23 CH 23

32 CH 32

33 CH 33

34 CH 34

35 CH 35

36 CH 36

37 CH 37

38 CH 38

39 CH 39

48 CH 48

49 CH 49

50 CH 50

51 CH 51

52 CH 52

53 CH 53

54 CH 54
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55 CH 55

9. Flip the little rocker switch on the bottom of the BNC input as follows:

If your sensor is differential and grounded, set the switch to "GS"

If your sensor is differential and floating, set the switch to "FS"

If your sensor is single-ended, set the switch to "FS"

10. Repeat steps 3-9 for each sensor that you wish to hook up to MiDAS 4.0 data
acquisition .

11. When done hooking up all your sensors, click on the OK button.

Note: Consult with your sensor manufacturer for specific details regarding your
sensor(s). MiDAS 4.0 BNC Breakout Boxes accept -10V to 10V signals (the standard
in the data acquisition industry). If your sensors put out more than this voltage, you
should place a voltage divider in line between the sensor and the BNC Breakout Box,
or consider using the MiDAS 5B+ Rack with voltage divider hardwares.

Connecting Sensors to the MiDAS 4.0
5B+ Rack

The MiDAS 4.0 DA-123B hardware includes a 16-channel 5B+ Rack and special
cable. The MiDAS 4.0 5B+ rack is a derivative of the series of "5B" hardware
manufactured by Analog Devices and sold through numerous worldwide distributors.
The 5B+ hardware has a distinct advantage over the standard BNC breakout box in
that it directly accepts a complete line of signal conditioner hardwares for modifying
signals from sensors. The MiDAS 4.0 5B+ rack is depicted in the following diagram,
completely populated with 16 signal conditioner hardwares:

A list of the available 5B+ signal conditioner hardwares is as follows:

Frequency Measurement hardwares
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Frequency hardwares convert input frequency from encoders, gauges, tachometers to
output voltage (0-5VDC).

Input Range Output Range Bandwidth Part Number

0-5kHz 0-5V 10Hz M5B-FI45-04

0-10kHz 0-5V 10Hz M5B-FI45-05

0-25kHz 0-5V 190Hz M5B-FI46-01

0-50kHz 0-5V 190Hz M5B-FI46-02

0-100kHz 0-5V 190Hz M5B-FI46-03

0-250kHz 0-5V 190Hz M5B-FI46-04

Voltage Measurement hardwares
Voltage hardwares amplify or reduce DC input voltages to ±5VDC for MiDAS input.

Input Range Output Range Bandwidth Part Number

±10mV ±5V 10kHz M5B-VI40-01

±50mV ±5V 10kHz M5B-VI40-02

±100mV ±5V 10kHz M5B-VI40-03

±1V ±5V 10kHz M5B-VI41-01

±5V ±5V 10kHz M5B-VI41-02

±10V ±5V 10kHz M5B-VI41-03

±20V ±5V 10kHz M5B-VI41-07

±40V ±5V 10kHz M5B-VI41-08

Current Measurement hardwares
Current hardwares convert sensor output currents to output voltage (0-5V).

Input Range Output Range Bandwidth Part Number

0-20mA 0-5V 4Hz M5B-CI32-02

5B Strain Measurement hardwares
Strain Gauge hardwares both provide bias "excitation" voltage to the sensors and
convert isolated strain gauge inputs to output voltage (0-5V).
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Input Range Output Range Sensitivity Bandwidth Part Number

±30 mV @ 10
V Excitation

±5V Full
bridge300-10kO

10 kHz M5B-SG38-02

±30 mV @ 10
V Excitation

±5V Half
bridge300-10kO

10 kHz M5B-SG38-04

±20 mV @ 10
V Excitation

±5V Full
bridge300-10kO

10 kHz M5B-SG38-05

5B Temperature Measurement hardwares
Temperature hardwares provide power to thermocouples and convert temperature
from a thermocouple with cold-junction compensation (CJC) to voltage (0-5DC).

Type / Input Range Output Range Accuracy Part Number

J type/0-760°C 0-5V ±.05% M5B-TI37-J1

K type/-100-1350°C 0-5V ±.05% M5B-TI37-K1

T type/-100-400°C 0-5V ±.05% M5B-TI37-T1

E type/0-900°C 0-5V ±.05% M5B-TI37-E1

R type/0-1750°C 0-5V ±.05% M5B-TI37-R1

S type/0-1750°C 0-5V ±.05% M5B-TI37-S1

B type/0-1800°C 0-5V ±.05% M5B-TI37-B1

C type/-100-1300°C 0-5V ±.05% M5B-TI37-C2

To connect sensors to your MiDAS 4.0 DA-123B hardware:

1. Connect your MiDAS 4.0 data acquisition hardware per the instructions in
Chapter 2, Installing MiDAS 4.0.

2. Replace the BNC breakout box and shielded cable with the 5B+ rack and ribbon
cable.

3. Click on the wrench button located next to channels next to theData section in
the Recording tab. The DATA ACQUISITION SETTINGS dialog box will open.
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4. First, you must tell MiDAS 4.0 which type of DAQ hardware you are using.
Select 5B+ RACK in the DAQ Configuration window.

5. Determine the type of sensor that you are using (see the instruction manual that
came with your sensor for more details).

6. Starting with Channel 0, select a channel.

7. Click the ON checkbox next to the channel you selected.

8. Configure MiDAS 4.0 with the specific information about the sensor. Note that
all 5B+ signal conditioner hardwares are reference single ended (e.g. RSE ).

9. Set the information about each channel on which you are acquiring analog data
per the following instructions. Use the information coming out of the 5B+
hardwares (typically +/-5V or 10V range). Set the scale factor as the product of
the sensor and the signal conditioner amplification.

DAQ hardware being used The options are BNC Breakout Box(es) or
Terminal Block. If you are using the
supplied BNC Breakout Boxes, select BNC
BREAKOUT BOX(ES) See above.

Channel MiDAS 4.0 automatically determines and
displays which channels are available based
on which hardware you have purchased
which type of DAQ hardware you have
chosen and which type of sensors you have
already configured. Starting with the next
sequentially available channel (start with
Channel 0) and check the box to enable that
channel.

Input Mode The three options here are DIFF, RSE and
NRSE. See the above description to
determine which type of sensor you are
using. If you do not know which type of
sensor you have, and the sensor was
provided with a BNC connector, try DIFF
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mode.

Label Provides a short (4 character) label for the
analog input channel. This label is printed
on the melded AVI file. We recommend
using lower case letters only.

Units A short (3 character) field for placing units
in the graphs. We recommend using lower
case letters only.

Lower Limit The lower limit, in volts, that you expect to
see from your sensor. MiDAS 4.0 magnifies
the dynamic range of the input from Lower
Limit to Upper Limit. Voltages that exceed
the lower limit in this field will appear as
clipped or under-saturated. A small amount
of over scan has been automatically
provided. Typical bi-polar sensors have an
input range of -10V to +10V. Typical
uni-polar sources have an input range of 0V
to +10V.

Upper Limit The upper limit, in volts, that you expect to
see from your sensor. MiDAS 4.0 magnifies
the dynamic range of the input from Lower
Limit to Upper Limit. Voltages that exceed
the upper limit in this field will appear as
clipped or saturated. A small amount of over
scan has been automatically provided.
Typical bi-polar sensors have an input range
of -10V to +10V. Typical uni-polar sources
have an input range of 0V to +10V.

Factor The scale factor to be applied by MiDAS 4.0
to convert the input volts to a meaningful
number, in engineering units. This number is
applied immediately after the input voltage
is registered.

Offset The offset to be applied by MiDAS 4.0 to
account for drifts or offsets in the input, in
units. This offset is applied after the scale
factor multiplication.

PLOT COLOR button The color of the line to be used in
multiple-line graphs. Select this button to
bring up the color palette.
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UPDATE button When clicked, this button causes the table to
be updated with the new information.

SET AS DEFAULT button When clicked, this button causes the current
data configuration to be saved as the default
for all future measurements. When the
MiDAS 4.0 data acquisition hardware is
opened subsequently, the default
configuration will be present.

OK button Exits the screen without further data saving.

10. Click on the UPDATE button.

11. Insert your 5B signal conditioner hardwares into the 5B+ rack. Make any
adjustments to the hardwares (settings, voltage jumpers, etc.) at this time.

12. Connect your sensor directly to the 5B signal conditioner hardwares.

13. Repeat steps 5-12 for each sensor you attach (up to 16).

14. Power up the 5B+ Rack with the power supply.

15. Adjust your offset values as necessary.

Note: Consult both your sensor manufacturer and/or the instructions that came
with your 5B signal conditioner hardwares for instructions on connecting your
sensors to the signal conditioner hardwares. Some sensors require 3 wires, some
require 2, and some require reverse bias. Most 5B hardwares accept both
differential and single ended sensor inputs.

16. Configure your channels. When using the MiDAS 4.0 5B+ rack, connect your
sensors as shown in the following chart:

MiDAS Pro Channel (as selected in
Settings Window)

Connect Sensor to 5B Rack Position

0 1

1 2

2 3

3 4

4 5

5 6

6 7

7 8

8 9
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9 10

10 11

11 12

12 13

13 14

14 15

15 16

Note: Factor in any scaling or amplification caused by the 5B signal conditioner
when setting channel information. For example, if the signal conditioner is a 2x
voltage divider, the MiDAS 4.0 scale factor must be multiplied by 2x for accurate
acquisition.

Connecting Sensors to the Terminal
Blocks

1. Replace the BNC breakout box and the BNC extended breakout box if you have
an extended analog hardware with terminal blocks.

2. Click on the wrench button located next to channels next to theData section in
the Recording tab. The DATA ACQUISITION SETTINGS dialog box will open.

3. Select CB/SCB TERMINAL BLOCK(S) in the DAQ Configuration window.

4. Select the appropriate channel (e.g. "Channel 0") from the drag-down box. If that
channel is available, click the ON checkbox. Start with Channel 0 always. If

84 MiDAS 4.0 User Manual



Channel 0 is not available (already in use), then use Channel 1. If Channel 1 is
already in use, then use Channel 2, and so on, until you find an available channel.
Increment upwards as you proceed. MiDAS 4.0 automatically detects available
channels. You cannot override this setting.

5. Determine the type of sensor that you are using (see the instruction manual that
came with your sensor for more details).

6. Determine the parameters of the sensor (gain, offset, voltage range, calibration).
Make sure you factor in the signal conditioning amplification, if appropriate.

7. Configure MiDAS 4.0 with the specific information about the sensor and (if
applicable) signal conditioner. Set the information about each sensor on which
you are acquiring data. The following chart shows the options for configuring a
sensor. Enter all the information requested.

DAQ hardware being used The options are BNC Breakout Box(es) or
Terminal Block. If you are using the
supplied BNC Breakout Boxes, select BNC
BREAKOUT BOX(ES) See above.

Channel MiDAS 4.0 automatically determines and
displays which channels are available based
on which hardware you have purchased
which type of DAQ hardware you have
chosen and which type of sensors you have
already configured. Starting with the next
sequentially available channel (start with
Channel 0) and check the box to enable that
channel.

Input Mode The three options here are DIFF, RSE and
NRSE. See the above description to
determine which type of sensor you are
using. If you do not know which type of
sensor you have, and the sensor was
provided with a BNC connector, try DIFF
mode.

Label Provides a short (4 character) label for the
analog input channel. This label is printed
on the melded AVI file. We recommend
using lower case letters only.

Units A short (3 character) field for placing units
in the graphs. We recommend using lower
case letters only.

Lower Limit The lower limit, in volts, that you expect to
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see from your sensor. MiDAS 4.0 magnifies
the dynamic range of the input from Lower
Limit to Upper Limit. Voltages that exceed
the lower limit in this field will appear as
clipped or under-saturated. A small amount
of over scan has been automatically
provided. Typical bi-polar sensors have an
input range of -10V to +10V. Typical
uni-polar sources have an input range of 0V
to +10V.

Upper Limit The upper limit, in volts, that you expect to
see from your sensor. MiDAS 4.0 magnifies
the dynamic range of the input from Lower
Limit to Upper Limit. Voltages that exceed
the upper limit in this field will appear as
clipped or saturated. A small amount of over
scan has been automatically provided.
Typical bi-polar sensors have an input range
of -10V to +10V. Typical uni-polar sources
have an input range of 0V to +10V.

Factor The scale factor to be applied by MiDAS 4.0
to convert the input volts to a meaningful
number, in engineering units. This number is
applied immediately after the input voltage
is registered.

Offset The offset to be applied by MiDAS 4.0 to
account for drifts or offsets in the input, in
units. This offset is applied after the scale
factor multiplication.

PLOT COLOR button The color of the line to be used in
multiple-line graphs. Select this button to
bring up the color palette.

UPDATE button When clicked, this button causes the table to
be updated with the new information.

SET AS DEFAULT button When clicked, this button causes the current
data configuration to be saved as the default
for all future measurements. When the
MiDAS 4.0 data acquisition hardware is
opened subsequently, the default
configuration will be present.

OK button Exits the screen without further data saving.
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8. Click on the UPDATE button.

9. Physically connect your sensor to the CB-68LP Terminal Block(s)

Note: MiDAS 4.0 can accommodate both differential and single ended inputs.
Mix and match them as required by your application.

If your sensor is differential, grounded or differential, floating:

• Connect the signal (+) lead and the negative (-) lead from your sensor to the
screw terminals on the Terminal Block corresponding to the selected MiDAS
channel you selected in Step 3 above. Use the following two charts to
determine which terminals to use.

Note: For example, if you selected Channel 5 in Step 3 above, then you
connect the positive lead to terminal (pin) # 60 and the negative lead to
terminal (pin) #26.

If you have MiDAS 4.0 data acquisition models DA-123M, -124M, -162M,
-160M, DA-170M, you can connect up to 8 Differential Input Sensors into
the Terminal Block:

Terminal Block

MiDAS Channel (as
selected in Settings
Window)

Connect DI Sensor Signal
(+) to pin #...

Connect DI Sensor
Negative (-) to pin #...

0 68 34

1 33 66

2 65 31

3 30 63

4 28 61

5 60 26

6 25 58

7 57 23

If you have MiDAS 4.0 data acquisition module DA-171M, you can connect
up to 32 differential inputs into your two terminal blocks. The first eight
sensors are connected to the block connected to the cable labeled "MIO-68"
and the remaining 24 sensors are connected to the block connected to the
cable labeled "MIO-68 Extended Analog Input," as follows:

Terminal Block

MiDAS Channel (as
selected in Settings

Connect DI Sensor Signal
(+) to pin #...

Connect DI Sensor
Negative (-) to pin #...
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Window)

0 68 34

1 33 66

2 65 31

3 30 63

4 28 61

5 60 26

6 25 58

7 57 23

Extended Terminal Block

MiDAS Channel (as
selected in Settings
Window)

Connect DI Sensor Signal
(+) to pin #...

Connect DI Sensor
Negative (-) to pin #...

16 68 34

17 33 67

18 32 66

19 65 31

20 30 64

21 29 63

22 62 28

23 27 61

32 26 60

33 59 25

34 24 48

35 23 57

36 55 21

37 20 54

38 19 53

39 52 18

48 17 51

49 16 50

50 49 15

51 14 48

52 13 47
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53 46 12

54 11 45

55 10 44

• If your sensor is differential floating, you must also connect a bias resistor to
the common lead from your sensor. Connect the other side of this termination
to any of the Analog Ground screw terminals pins 24, 27, 29, 32, 56, 59, 64,
or 67. See the diagram in the previous section for details on this bias resistor.

If your sensor is single-ended:

• Connect the signal (+) lead from your sensor to the screw terminals on the
CB-68LPR Terminal Block corresponding to the selected MiDAS channel.
MiDAS will automatically display only those channels that are available to
you based on the data acquisition hardware model you have.

If you have MiDAS data acquisition models DA-123M, -124M, -162M,
-160M, DA-170M, then you can connect up to 16 sensors to your CB-68LPR
Terminal Block:

MiDAS Pro Channel (as selected in
Settings Window)

Connect SE Sensor Signal (+) to Screw
Terminal #...

0 68

1 33

2 65

3 30

4 28

5 60

6 25

7 57

8 34

9 66

10 31

11 63

12 61

13 26

14 58

15 23
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If you have MiDAS 4.0 data acquisition module, DA-171M, you can connect
up to 64 single-ended sensors to the two terminal blocks (one on each end of
the cable). You must connect the first 16 sensors to the terminal block
connected to the cable labeled "MIO-68" and the remaining 48 sensors on the
second block (on the cable labeled "MIO-68 Extended Analog Input"), as
follows:

Terminal Block

MiDAS Pro Channel (as selected in
Settings Window)

Connect SE Sensor Signal (+) to Screw
Terminal #...

0 68

1 33

2 65

3 30

4 28

5 60

6 25

7 57

8 34

9 66

10 31

11 63

12 61

13 26

14 58

15 23

Extended Terminal Block

MiDAS Pro Channel (as selected in
Settings Window)

Connect SE Sensor Signal (+) to Screw
Terminal #...

16 68

17 33

18 32

19 65

20 30

21 29

22 62
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23 27

24 34

25 67

26 66

27 31

28 64

29 63

30 28

31 61

32 26

33 59

34 24

35 23

36 55

37 20

38 19

39 52

40 60

41 25

42 58

43 57

44 21

45 54

46 53

47 18

48 17

49 16

50 49

51 14

52 13

53 46

54 11

55 10

56 51
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57 50

58 15

59 48

60 47

61 12

62 45

63 44

• If your sensor is single-ended grounded (NRSE), connect the common lead
from your sensor (or sensor system) to screw terminal 62 (AISENSE) of
either terminal block.

If your sensor is single-ended floating (RSE), connect a bias resistor to the
common lead from your sensor(s). Connect the other side of this termination
to any of the analog ground screw terminals pins 24, 27, 29, 32, 56, 59, 64, or
67.

10. Repeat steps 3-9 for each sensor that you wish to connect to MiDAS 4.0.

Note: Always start at Channel 0 and proceed upwards, using the above charts.

Note: MiDAS 4.0 will advise you of available and unavailable channels based on
the type of hardware and sensor selection. MiDAS 4.0 will accept mixed
differential, RSE and NRSE sensors. Always set the sensor type in MiDAS 4.0
prior to connecting the sensor and the signal conditioner to the Terminal Blocks.

11. When done connecting all your sensors, click on the OK button.
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Chapter 8. Event Triggering
Understanding How MiDAS 4.0 Records
Events

To prepare your recording projects, it is beneficial to understand how the different
subsystems in MiDAS 4.0 work together, and how to configure them through MiDAS
4.0 for optimal results. In this section we will review the camera memory buffer and
how to use triggering in respect to the memory buffer.

Understanding Memory Buffers
While MiDAS 4.0 is recording video from the cameras controlled by MiDAS 4.0, the
video frames are streamed directly to RAM on board the camera, Frame Grabber card,
or to the computer's memory, depending on the type of camera. Data is stored in the
computer's memory. These combined memory sections are termed the buffer, and the
buffers operate on the First-In First-Out principal. There is a limited amount of
memory reserved for these operations. To keep the data current once the memory is
full, the oldest is discarded to make room for the most recent. The way you configure
these systems, through MiDAS 4.0, will allow you to capture the event of interest. The
quantity of information you can store is fixed. How you configure MiDAS 4.0 will
affect your different parameters. For example, reducing your resolution will increase
the number of frames you can capture, and decreasing the sampling frequency of data
sensors will, in kind, increase the amount of time for which you can sample data.

The Circular Buffer Concept
Consider the following bar to represent a memory buffer, in this example 128 Mb.

MiDAS 4.0 collects video and data into the buffer on a first-in-first-out basis. Once
the buffer is full, the program starts to overwrite the oldest data, so that the most
recently captured information is always available in the memory buffer.

This process of continuously writing in a loop is called a Circular Buffer. For that
reason it is useful to examine the buffer with this diagram.



If you look at an example of recording a track runner, this will show why triggering
performance is so significant. Obviously the race, start to finish is the informational
set that you are interested in. Any video data before the start, or after the finish is not
of interest, so you have to configure the triggering to capture this event. If you assume
that 500 frames are needed to record the event, and that the max frames, based on the
frame rate and resolution, is 525 frames without proper triggering you may miss
important parts of the event.

If you were to trigger off of a microphone input with the sound of the starting gun, the
data of concern will all happen post trigger. Therefore, you want to set the Trigger
adjust to 0% which will allow for all frames saved to be after the trigger. This will
allow for your video to start immediately after the starter gun.

If instead, you want to trigger with the runner crossing the finish line, the data you
want is already in the buffer at the time of the trigger, so you want to adjust the trigger
to 100% which will give you all of the information already collected, 100%
pre-trigger. If you are to trigger the recording when the runner passes the half way
mark, you will then want to trigger at 50%. If you have extra frames you can adjust all
of the above by a few percentage points, to collect a few frames before or after the
action of interest. The reporting boxes below will tell you how much time, and how
many frames will be collected pre and post trigger.

MiDAS 4.0 will continue recording and collecting video and data into the Circular
Buffer until it receives a command to stop and save the collected information, or abort
the recording.

The Trigger Command and Settings
Triggering, regardless of type, does two things:

1. Signals the camera and any data card, how and when to institute memory buffer
saving as you have configured it.

2. Establishes the reference frame at the point in time in which the trigger event
was received.
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Triggering does not necessarily stop a recording immediately. The relationship
between the time at which the trigger signal is received and the time at which the
recording is stopped is governed by the Trigger Adjust setting on the Record tab of
the control panel. The Trigger percentage indicates the pre-trigger portion of the total
acquisition, for a given collection of video images or data points. The remainder of
information will be collected post-trigger.

For example, a trigger percentage of 0% instructs the MiDAS 4.0 software to tell the
camera to make the current frame, at the time of the trigger,zero and then collect a full
buffer of frames and data as configured. A trigger percentage of 100% instructs
MiDAS 4.0 to stop acquisition immediately upon receipt of a trigger input (acquire
100% before the trigger and 0% after the trigger) and make the final frame of the
sequence the zero frame, or reference frame.

The reference frame, or zero frame, is always the frame that is concurrent with when
the trigger was received. Within any video, or data sequence, any frames with a
negative number occurred before the trigger was received; frames with a positive
number occurred following the trigger. It should be noted, however, that the reference
frame of video and the reference datum do not necessarily coincide (see the Data
Buffer Lengths and Triggering section below for further explanation).

If the trigger % is and you have
recorded

and the event is then MiDAS 4.0
will

100% a full buffer Trigger or Stop Stop and return a
full buffer, as
recorded.

100% a partial buffer Trigger or Stop Stop and return only
those frames that
were recorded.

0% a full or partial
buffer

Trigger Continue recording
one full buffer
more, stop and
return a full buffer.

0% a full buffer Stop Stop and return a
full buffer.

0% a partial buffer Stop Stop and return only
those frames that
were recorded.

0% < t < 100% a full buffer Trigger Continue to record
the proscribed
number of
post-trigger frames,
then stops and
returns a full buffer.

0% < t < 100% a partial buffer Trigger Continue to record
the prescribed
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number of
post-trigger frames,
and return the
available pre-trigger
and the full
post-trigger frames.

0% < t < 100% a full buffer Stop Stop and return a
full buffer.

0% < t < 100% a partial buffer Stop Stop and return only
the frames that were
recorded.

Exposure Time and Frame Counting
If you have chosen an exposure time greater than 1.0X ,the camera will not acquire an
image during the entire frame duration. Depending on the frame rate you have chosen,
there is a fixed length of image acquisition. This period is a simple inverse ratio. If
your frame rate is 500 frames per second the full exposure time is 1/500th of a second.
This is for a full exposure (based on time, not related to any stops you may be using),
you can reduce this electronic shutter speeds and decrease the amount of exposure
time, for scenes that have a surplus of light. When you utilize a shutter speed in excess
of 1.0X, the time that the sensor is gathering light is less than full exposure time. For
the above example, if the Frame rate is 500 fps, and the shutter speed is 2.0x the
exposure time of the sensor array will be 1/1000 of a second (1000 µsec). The
mathematical representation of this is 1/

(n*Frame Rate)
= Exposure Time, where n is the

selected Shutter Speed.

A video frame is defined as the total time between exposures. The following drawing
illustrates this relationship:

Depending on your type of camera, the exposure time will either be at the leading
edge of the frame, or the trailing edge. Consult your camera manual for information
specific to your camera.

This has important implications for recording video. If a trigger pulse is received
during the inactive period of a frame, that frame will still be defined as the reference
frame and the next frame the first post-trigger image. The result is that the reference
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frame will be blank, and the first frame with an image will be frame #1. This is
because the electronic shutter was "closed" when the trigger was received, and the
acquisition of the image for the next frame had not begun yet.

Triggering vs. Stopping and Aborting
Recordings

The normal mode of operation is to instruct MiDAS 4.0 to stop and save a recording
when it receives a trigger. You may also force MiDAS 4.0 to stop a recording before
receiving a trigger by clicking on the Stop button in the Record tab. This immediately
stops the recording function, returns all of the frames in the buffer acquired prior to
receiving the Stop command, and places the reference frame at the end of the
sequence. In other words, the Stop command behaves as if the trigger were set to
100%, no matter what the actual setting is. Once MiDAS 4.0 has carried out a trigger
command or received a stop command, the program automatically switches from
Record mode to Play mode.

The Reference Frame and Reference
Data Point

MiDAS 4.0 places the reference frame and video/data per the following rules:

If... MiDAS 4.0 returns... The reference frame is...

the buffer has been filled
prior to Trigger,

a full buffer of video/data. the frame during which the
trigger was received.

the buffer has been filled
prior to Stop,

a full buffer of video/data. the last frame recorded.

the buffer has not been
filled prior to Trigger,

all frames acquired prior to
trigger and the desired
number of post-trigger
frames.

the frame during which the
trigger was received.

the buffer has not been
filled prior to Stop,

all frames acquired prior to
Stop.

the last frame recorded.

the buffer has not been
filled, Trigger has been
executed, and then Stop
executed,

all frames acquired prior to
Stop. No frames

the frame during which the
trigger was received.

Note: Some cameras do not add a frame after receiving an external trigger. That is, if
the trigger is set to 100% and an external event trigger is received in the middle of a
video frame, the camera immediately stops and returns all the frames prior to the
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trigger frame. In this case, there is no reference frame, and the last frame is frame
number -1. Most cameras continue recording for one or two frames after receipt of an
external trigger ensure that the trigger frame is captured.

Data Buffer Lengths and Triggering
MiDAS 4.0 handles both video and data. Often data is collected at a much higher rates
than video. MiDAS 4.0 simplifies the integration of your video and data by controlling
the different rates of video and data capture through hardware management.

The number of data points per frame of video is referred to as the samples per frame
or sample rate. Part of configuring MiDAS 4.0 for recording is selecting the samples
per frame, which, along with the amount of video frames to acquire and the trigger
location, will determine the number of data samples that will be acquired.

When your Trigger Percentage is less than 100% and more than 0%, and the points
per frame are greater than 1, the point of reference for your 0 data needs to be
determined. When you have just completed a recording, you will switch to the Play
mode. The default will be Video Centric mode. In this mode, the 0 data point will be
referenced to the time of the 0 video frame. The 0 video frame is the video frame
during which the trigger occurred.

You may then choose to switch to Data Centric mode. In Data Centric mode, the 0
data point is the data point that occurs immediately following the trigger. This may or
may not correspond to the 0 Video frame. The 0 video frame will continue to be the
video following during which the trigger occurred. In a data-only project, the 0 data
point is always that data point, immediately following the trigger.

It is important to note that the number of data points captured post trigger is calculated
independent of the amount of video frames captured post trigger. Consider a video
consisting of 6 video frames, with 5 data points per frame, and a trigger percentage of
40% post trigger.

If the trigger is received between the second and third data point of the 0 video frame,
we will have 12 post trigger data points. The final video frame has only four
corresponding data points, even though we were acquiring 5 data points per frame.
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If the trigger is received between the fourth and fifth data point of the 0 video frame,
we will still have 12 post trigger data points. However, the final video frame will have
5 data points.
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Chapter 9. Saving and Loading
The term video in this section is interchangeably defined as either 1. a single video file
that contains a series of frames, or 2. a sequence of individual still image files, each
sequentially numbered for playback in the correct order. The most common video
format is .avi. The most common formats for image sequences are .bmp and .tif.

The nature of saving multiple related files with associated data, frame annotations and
other information, can be complex. MiDAS 4.0 simplifies many of these issues and
offers a variety of ways of saving files to assist in your organization, depending on
what file(s) you want to save, and how you want to save them. When saving, you can
limit the range of frames to reduce the file size, and limit it to the area of interest. You
can also save videos in different file formats.

It is important to understand what you want to save. In this section we will explain the
different saving procedures. When saving any video or data file, MiDAS 4.0 will
automatically recognize the type of file you are trying to save, and present the
appropriate Save As window. If you have multiple files, MiDAS 4.0 will recognize
this as well and present you with the Synchronized Save window.

Saving Video Files
Video files and data files may be saved independently. To save a video file without
synchronized data, make sure that the file you want to save is in the active window,
then continue with the following procedure:

1. From the File menu, choose Save Video/Data File As.... A dialog box will
appear.



2. Next to File name: type a name for the file.

3. Under Save as type: select the desired file format from the drop-down menu.

AVI File (*.avi) will save the file as a standard AVI. If you
select this option you will be asked to choose from a
selection of codec options, including no compression,
after you click save.

Bitmap Sequence (*.bmp) will save the video as a sequence of bitmap
images. As with all image sequences, it's important to
choose an easily identifiable filename, as saving a
sequence will create a large number of files, each with
an incrementing number on the end, representing frame
number.

JPEG Sequence (*.jpg) will save the video as a sequence of files
compressed in the *.jpg format. If you choose this
option, a separate dialog box will come up to allow you
to choose the compression level for each image. As with
all image sequences, it's important to choose an easily
identifiable filename, as saving a sequence will create a
large number of files, each with an incrementing number
on the end, representing frame number.

TIFF Sequence (*.tif) will save the video as a sequence of files
compressed in the *.tif format. As with all image
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sequences, it's important to choose an easily identifiable
filename, as saving a sequence will create a large
number of files, each with an incrementing number on
the end, representing frame number.

4. There are a variety of saving options that will allow you to modify the range of
frames you will save.

Save entire range This will save all frames in the video.

Skip every X frames This will allow you to drop a number of frames
equal to the integer you put in the frames box. For
instance, if you place 2 in the field it will drop two
frames, save a frame, then drop two frames, and
save a frame again. It will continue through the
video in this fashion until complete.

Span multiple files Select the check box to enable this function. Use
the slider or type an integer value in the text field
to set the frame length of each file. Saving with
this option will divide your video into multiple
files with the frame length that you specified. The
files will load and play seamlessly as though they
were one video. Although you can enable this
option for saving still image sequences, it will
have no effect.

Save frames This will allow you to choose a range of frames.
The range will be limited to a start and end frame
number that you specify.

Estimated size This displays the estimated size of the video file
based on the settings you have set.

Video Compression
If you have selected to save a video as an .avi file, MiDAS 4.0 will open the Video
Compression Assistant window. The various codecs listed in this dialog box are
provided by your operating system.

It is recommended that you save using the -No Compression- option. When video
compression is utilized, video information can be lost, and artifacts can be introduced.
MiDAS 4.0 provides these alternatives for your convenience when storage space is
limited. Using compression on videos that will be analyzed in the future is not
recommended.
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To use video compression:

1. In the upper scroll pane, select one of the video compression codecs listed. In the
lower pane, notes about the function of the chosen codec are displayed.

Note: The displayed list of codecs is derived from those codecs installed in your
operating system.

2. If you wish, you can preview that results of applying a codec on the saved file.
Click on the Preview button, and the window will expand to show two preview
windows and Start Preview and Stop Preview buttons. The uncompressed and
compressed videos will play concurrently.

104 MiDAS 4.0 User Manual



3. Click on the Start Preview button to start the video comparison preview. Click on
Stop Preview to stop it.

4. Press OK when you are ready to save the video.

Saving a Sequence of Image Files
It is possible to save a video as a sequence of still image files. This will create a large
number of files, one for each frame. Organization of these files is important. When
saving as a sequence MiDAS 4.0 will take your filename and append an underscore _,
followed by a number. The number is incremented for each consecutive frame.
MiDAS 4.0 will not allow you to overwrite previously saved files. It is recommended
that you create separate directories for each image sequence. This will help in
organization of the file sequences.

Saving Data Files
Video files and data files may be saved independently. To save a data file without
synchronized video, make sure that the file you want to save is in the active window,
then continue with the following procedure:

Chapter 9. Saving and Loading 105



1. From the File menu, choose Save Video/Data File as.... A dialog box will appear.

2. Next to File name: type a name for the file.

3. Under Save as type: select *.mdat format. This is the MiDAS 4.0 data format.

4. You may modify the range of data points you will save.

Save entire range This will save all data points.

Save range This will allow you to choose a range of data points
to save.

Saving Synchronized Video and Data
If your project contains video and data files with similar file names, the Synchronized
Save List dialog box will appear when you choose Save Video/Data File As... from
the File menu.

1. In the upper portion of the window will be a list of files that MiDAS 4.0 believes
are related. You can select which files you want to be synchronized by leaving
the checkbox on the left selected. If you do not want a file to be included in the
synchronization, just de-select the check box.

2. Open saved files in New Play Group will automatically create a play group file
containing all of the synchronized files, and open the videos in a new play group
window.

3. Present Save dialog for each window will prompt a separate saving dialog box for
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each file to be saved, allowing you to modify the save options.

4. If Use synchronized file naming convention is selected, MiDAS 4.0 will append
an incrementing label at the end of the file name: {D1}, {D2}, {D3} for data, and
{V1}, {V2}, {V3} for Video. This option is enabled by default.

Play Group Files
Play Group files (*.playgrp) contain a user-defined collection of video and/or data
files that are used in conjunction with each other. The MiDAS 4.0 Play Group system
allows the user to group these files together, and simplifies the opening of multiple
related files for analysis.

Saving Play Group Files
To save a play group, you must first open all of the various files that you want to
include in the play group. These can be any combination of video and/or data files.
Once you have opened those files, and you have assembled the play group as you
wish, you can save them as a play group. It is important to note that the play group file
does not include the actual video and data information. It is a list of references to the
location of the video and data files. The file references are relative to the directory in
which the play group file is saved. These play group files can be updated using any
text editor. It is recommended that you save the play group file in the same directory
as the video and data files. If the contents of the play group are saved in a network
directory, the play group file must be saved in the same network location, not on your
local machine.
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1. Open the video and data files you want to save in your play group. From the File
menu, select Save Play Group File As...

2. A Save Play Group File As dialog box will open. Select the desired file location,
enter a file name, and click Save.

MiDAS File Formats
MiDAS 4.0 saves information in a variety of file formats. It is important to know these
formats to keep them intact as a group when transferring files. It is best to keep all
associated files within the same directory. In addition, MiDAS 4.0 is backwards
compatable with the previous versions of MiDAS file formats. Below is a list of
current and legacy MiDAS file formats.
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AVI Standard Microsoft Windows Video format. MiDAS can save video into
the .avi file format, and play .avi formats, as long as the proper
codec is loaded on your computer.

BMP Standard bitmap image file format. MiDAS can save video as a series of
sequential .bmp images.

TIF Standard tag image file format. MiDAS can save video as a series of
sequential .tiff images.

JPG Standard jpeg compressed image file format. MiDAS can save video as a
series of sequential .jpg images.

MDAT MiDAS 4.0 data file. Tab-delimited text files that contain all the
information from data collection.

PLYGRP MiDAS 4.0 play group file. This is where MiDAS 4.0 stores the locations
of the various files that make up a play group.

CAM MiDAS camera file for the Lens Calculator. This file contains the
information about each camera (resolution, frame rates, etc.) for each
camera. CAM files are editable in a text editor.

NTV MiDAS 4.0 Notes storage file. This is where the MiDAS notes for a video
is stored. The .ntv file will be stored in the same directory, with the same
name as the file that it references.

XLS Standard Microsoft Excel file format, MiDAS 4.0 analysis data can be
saved in this format.

CFG MiDAS configuration file. Contains all the configuration information
about your video or data files, This is where MiDAS 4.0 stores the frame
rate, shutter speed, etc. of the original recording.

CLR MiDAS color balancing file. Contains the Bayer decoding coefficients for
color files, plus any color temperature settings and gray balance settings.

LUT MiDAS image processing look-up table values. Contains settings for
modifying an image using MiDAS image processing tools.

AU1 Reserved for MiDAS-LC data files

AU2 MiDAS 2.0 and previous data files. Tab-delimited text files that contain all
the information from data collection.

AU3 MiDAS Professional binary file. This file stores a variety of information
including MiDAS Notes, Tracked points withing a video, and other similar
forms of information.
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Chapter 10. Playing Projects
Viewing Recordings in MiDAS 4.0

Once you have successfully made a recording, MiDAS 4.0 switches into Play mode.
In Play mode, the controls associated with recording, both on the control panel and the
project toolbar, are replaced by controls for viewing, calibrating and processing
recorded video and data. In this chapter we will address the basic controls for
reviewing video in MiDAS 4.0. For more advanced settings and for information on
reviewing synchronized video and data, please refer to Chapter 7, Data Acquisition
Theory.

Opening Files for Review
If you have not just completed a recording or are opening a video file in a new
instance of MiDAS 4.0, begin by opening a new Play project, either by selecting New
Group in the File menu or by clicking on the New Play Project button on the
toolbar. Then choose Open Video File..., Open Data File..., or Open Play Group... in
the File menu. You may also click on the Open File button on the toolbar.

When MiDAS 4.0 is in Play mode, the control panel displays a Playback tab. The
Playback tab lists the open video and/or data files. It also lists recording information
for each file, such as rate, shutter speed, and size.



The Play Controls
There are four types of Play Controls to let you modify your workspace to your
preference. You can switch between the four panels by clicking on the Play Controls
icon on the toolbar .

1. Standard play bar.

2. Thin, or abridged play bar.

3. Long Play Bar used for greater slider resolution.

4. Play Control panel, docked under the control panel.

Basic Playback
Jump to first frame

Play backward

Play forward

Stop

Step back one frame

Step forward one frame
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Jump to last frame

Setting the Current Frame, Active Range and
Zero Frame
Directly beneath the playback buttons is a slider representing the range of the video
sequence. The green triangle indicates the current position, while the red area of the
slider indicates the active range of the sequence.

The slide bar allows you to quickly move to a specific part of the video. To advance
the video to a desired frame, click and drag the green triangle or single-click anywhere
within the active range (red region).

The blue rectangles at either end of the slider allow you to set the active range of the
video. Click and drag the blue rectangles to mark the beginning and end of the
playback range. Moving the blue rectangles does not crop the video permanently.
Double-clicking anywhere on the slider will expand the active range to span the entire
video.

The frame number and time of the current frame relative to the zero point are
displayed next to the playback slider. Click the Zero button to set the current video
frame and its corresponding data point as the zero reference. Video frames and data
points prior to the zero reference will numbered with negative values. Video frames
and data points after the zero reference will be numbered with positive values.

The Jump button allows you to enter a frame number and immediately jump to that
frame. If the frame number you enter is outside of the active range, MiDAS will jump
to the nearest frame.

Setting the Playback Rate
Set the playback rate by clicking and dragging the slider post towards the right or left.
The actual playback rate is determined by many factors, including the number of
synchornized videos, the video RAM, and the speed of the computer processor. The
average playback rate may displayed below the playback rate slider in frames per
second (fps).

The playback ratio setting allows you to select the ratio of frames displayed to actual
frames. The default setting is 1:1, which plays all frames. A ratio of 1:n, where n is an
integer greater than 1, plays every n frames and increases the playback rate. Adjust the
value of n by clicking on the up and down arrow buttons.
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Continuous and Synchronized Playback
The C checkbox selects a continuous playback mode. When this option is selected, the
video will play in a loop, going back to the beginning of the video when it reaches the
last frame.

The S checkbox selects synchronized playback. This option allows for the
synchronization of the playback of multiple video files. When synchonized, two or
more videos and data sets will play at the same frame rate.

To enable synchronized playback, do the following:

1. Position each video at the desired initial frame for synchronized playback.

2. Select the S checkbox in the play control panel for each video. This sets the
starting position to the current frame for each video.

3. Press the Play button in any one of the synchronized video display windows, and
all the synchronized windows will play simultaneously.

To remove a video from synchronization:

1. Stop the playback and click in the video window that you would like to remove
from synchronization.

2. De-select the "S" checkbox in the play control panel.

3. Resume playback.

The B checkbox (base synchronization) will be automatically checked when opening a
play group that utilizes it. Base Synchronization is the inherent synchronization of a
video and data set that was recorded together originally. It is normal to keep this
synchronization in place during playback.
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Chapter 11. Scene Calibration
Overview

In order to correlate a video image with real-world measurements, we must first
calibrate the image.

Calibrating an image:

• converts video pixel values to real-world dimensions (e.g. inches, meters, etc.),

• rotates the image to compensate for any unwanted tilt introduced during recording

• establishes an origin (0,0) and X,Y coordinate system for motion analysis
(direction of motion).

In order to calibrate an image, MiDAS 4.0 needs measurement information about
some feature in the image. We suggest that you include a horizontal ruler in the
picture or some equivalent frame of reference that has both a well-defined scale and
known rotational orientation. After an image is calibrated, you can change the units of
measure at any time.

Image calibration is controlled by the settings on the Calibration tab in the control
panel.

Calibrating the Scale
In order to set the calibration scale:

1. Within the video image, find a known reference object. Left-click on one end of
the object, using the reticle as a guide.

2. In the Calibration tab, click on Set Point #1.

3. Within the video image, left-click on the other end of the object.

4. In the Calibration tab, click on Set Point #2.

5. Type the distance between the points and choose the unit of measure from the
drop-down menu.

6. Click on the Apply Scale >> button to set the scale factor.



7. The calibration will apply to the recorded image, until either the recording is
closed, or the calibration settings are saved or loaded.

Calibrating the Coordinate System
The coordinate system is defined to include the origin (0,0 point) and the X and Y
axes. The coordinate system is used in the motion analysis of video.

To calibrate the origin and axes of the coordinate system:

1. Choose a point in the image that will serve as the origin of your coordinate
system. Left-click on that point, using the reticle as a guide. On the Calibration
tab, click on Set Origin. The coordinate system marker moves such that its 0,0
position is on the selected point.
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If View Calibration is selected in the contextual menu, the previous marker
position is shown in purple, and the current marker position is shown in red.

2. Left-click on the image at a point along the positive X-axis direction. The
coordinate X,Y markers will rotate to align the X direction with the new reticle
position.

3. In the Calibration tab, click on the X Direction button.

4. In the image, the coordinate markers will automatically rotate to align the X axis
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between the origin and the current point.

5. A default Y-axis will also be drawn at a 90-degree angle to the X-axis. To flip the
Y axis (e.g. reverse the positive Y direction), click on the Flip Y button in the
Calibration tab.

6. Click on the Apply Origin & Tilt >> button to set the calibration. The origin
location and the tilt angle are shown in the text boxes on the Calibration tab.

Saving and Loading Calibration
Settings

This feature is not currently available in MiDAS 4.0.

Displaying Calibration
The calibration markings can be toggled on and off at any time - for example, during
image processing, during analysis or during normal viewing. Right-click in the video
in which you want to turn calibration on or off and Analysis > View Calibration from
the contextual menu. If calibration markings are still visible after you have deselected
View Calibration, switch to a tab other than Calibration in the Control Panel.
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Chapter 12. Video Analysis
Feature Tracking

MiDS 4.0 allows for the manual tracking of features. This gives the user the ability to
select a distinct feature and determine its frame by frame motion characteristics like
position and velocity over time, with respect to the plane of the image. Manual
tracking requires the user to step through the video one frame at a time, using the muse
and reticle to select the location of the feature in each frame.

MiDAS 4.0 can have a maximum of 64 features defined for tracking. A feature as
described as the time series of a point of interest in the video. A feature is made up of
individual points, one per each frame of video. Each point is defined by the user.

Enable/Disable This enables and disables feature tracking.

Load If you have done a previous feature
tracking on a video, you can save and
apply it to a video later. Tracking
information is saved separately from the
video. Feature track files have the .ftk
file extension.

Save You can save your feature track analysis
and configuration to a file for application



to the video file in the future. All feature
track files have the .ftk file extension.

Show points This drop down menu allows you to
manage which tracking points will be
shown on the current frame. This will
help you to clear the screen while
selecting points. The choices here are
applied to all features. The choices are:
Show All - shows all tracking points ;
Show Past - shows tracking points for all
previous frames ; Show Current - shots
tracking points in the current frame only ;
Show None - hides all tracking points.

Add Click this button to add a feature to the
set.

Remove Removes a feature and its associated
tracking points. Select the feature in the
list of features below the remove buttons,
then click the Remove button.

Clear Click this button to clear all tracking
points associated with the selected
feature.

Set point Once you have selected a point, slick the
select point button. This will commit the
point to tracking. Once you have selected
a point for each feature in a frame, the
video will advance one frame. You can
also perform "Set Point" by using CTRL
+ right-click.

Export Once you have completed your tracking
you can export the data to a text or Excel
file. You can choose your desired unit of
measure from the drop-down menu;
pixels are the default. If you have
calibrated your video, you can export in
engineering units. Select the data file
format from the second drop-down menu.
The choices are: Text - comma delimited
.txt file with header information ; Excel
Blank - Excel spreadsheet with no
formatting ; Excel Formatted - Excel
spreadsheet with a pre-configured
template.

Once you have configured your export
parameters, click the Export button. If you
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are using text format or blank Excel
format you will be prompted to save the
file, once you click save the file will open
in the associated program. If you are
using Export with an Excel Format, you
will be prompted to choose the Excel
template.

You can choose to track up to 64 Features, and you can configure them individually to
keep them organized.

Each feature is numbered as it is added. Double-click on the Feature Label field to
open the Track Settings dialog box and change the label. If you have not set the
Feature Label previously, <no label> is displayed in this field.

You can also modify the point marker. Double-click on the point to modify its style,
color, pen width, and size. The Marker Editor dialog box allows you to choose from 4
different marker styles: cross, X, triangle, and square. You can select a color from the
Windows color palette. In addition, you can choose the pen width (stroke boldness)
and size of the marker. The preview pane at the bottom will display your marker as
you have configured it.
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Next to each feature on the Analysis tab are three icons, an eye, a lock, and a wrench.
The Eye will enable or disable visibility of tracking points. The lock will disable the
addition of marked points. The wrench will open up the Track Settings dialog box.

Tracking
Once you have configured the features you wish to track, you can start to manually
track these features. In your video, locate the frame where you want to start your
tracking. Tracking will start with the feature highlighted in the Features pane of the
Analysis tab; make sure you select the feature you wish to start with.

Tracking

1. Left-click on the image at the location of the feature you wish to track. The
reticle wll snap to this location.

2. Click the Set Point button in the Analysis tab of the control panel. This will draw
a point marker on the image frame. The Features pane of the Analysis tab will
advance to the next feature in the list. Repeat this process for each feature. Once
you have marked one location point for each feature in the list, the video will
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advance one frame.

3. After you have tracked all of the features through the period of interest, you will
have full set of tracking points, as illustrated below. You can then save these
points to a MiDAS 4.0 .ftk file or export them to a text or Excel file using the
Export tool.
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Chapter 13. Caliper Tool
Overview

MiDAS 4.0 allows the user to make measurements directly within a video using the
Caliper feature. The Caliper tool allow you to measure length, distance, and velocity.
These measurements may be calibrated to real-world units using the Add Scale
Calibration button on the toolbar.

Calibrating the Scale
Calibrating the scale will allow you to measure distance and velocity in real-world
units such as meters and inches. You may calibrate the scale before or after using the
caliper tool. If you choose not to calibrate the scale in your image, the default
measurement units will be pixels and pixels/sec.

1. Click on the Add Scale Calibration button on the toolbar.

2. Click and drag on the image to draw a calibration line. The calibration line
should span an object or feature of known length.

3. The Length Calibration Properties dialog box will appear. Enter the real-world
length of the calibration line you drew. Click OK. The scale length will be
displayed on your image.



4. In the Length Calibration Properties dialog box, you can also adjust settings for
the appearance of the calibration line, including colors, line thickness, and font.

Using Calipers to Measure Length

1. Click on the Add Measurement Point button on the toolbar.

2. In the image, click on the beginning point of the length you want to measure. A
blue cross will mark this point.

3. Click on the Add Measurement Point button again.

4. In the image, click on ending point of the length you want to measure. A second
blue cross will mark this point.

5. Place your mouse cursor over the first measurement point that you added. The
blue cross will turn red. Next to the cross, the (x, y) coordinates of the point and a
measurement icon will appear.

6. Left-click on the measurement icon and drag towards the second measurement
point that you added in Step 4. A line will be drawn between the two
measurement points. The distance between the two points will be noted alongside
the line.
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7. If necessary, left-click and drag either of the blue measurement points to adjust
the caliper. The length annotation will update accordingly.

Using Calipers to Measure Distance and
Velocity

1. Click on the Add Measurement Point button on the toolbar.

2. Click on an object or feature in the image that you want to track. A blue cross
will mark this point .

3. Use the Play Controls to advance forward or backward to another frame in the
video. The object or feature that you want to track should have moved.

4. Click on the Add Measurement Point button again.

5. Click on the object/feature location in the current frame. A second blue cross
will mark this point .

6. Place your mouse cursor over the first measurement point that you added. The
blue cross will turn red. Next to the cross, the (x, y) coordinates of the point,
frame number, and a measurement icon will appear.

7. Left-click on the measurement icon and drag towards the second measurement
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point that you added in Step 4. A line will be drawn between the two
measurement points. The velocity of the point and the distance it moved will be
noted alongside the line.

8. If necessary, left-click and drag either of the blue measurement points to adjust
the caliper. The velocity and distance annotations will update accordingly.

Moving a Measurement Point in the Current
Frame

1. Left-click and drag the measurement point to adjust its location. The velocity
and distance annotations will update accordingly. If you are unable to move the
measurement point, the measurement point is in a different video frame.

Moving a Measurement Point in Another
Frame

1. Place your mouse cursor over the measurement point. The blue cross will turn
red. Click on the Go to Frame icon that appears to the right of the red cross.
The video will jump the the frame in which the measurement point is located.
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2. Left-click and drag the measurement point to adjust its location. The velocity
and distance annotations will update accordingly.

Moving a Measurement Point from One
Frame to Another

1. To move a measurement point from another video frame to the current frame,
place your mouse cursor over the measurement point. The blue cross will turn
red. Click on the Move Point icon that appears to the right of the red cross.

The measurement point will be moved to the current frame. If the Move Point
icon does not appear, the measurement point is already in the current frame.

Deleting Calipers
To delete a measurement point, left click on the measurement point and press the
Delete key on the keyboard. A dialog window will appear asking you to confirm the
deletion. Click Yes.
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Repeat these steps for each measurement point that you would like to delete. The
process is the same for deleting measurement lines and calibration lines. There is no
Undo function.
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Chapter 14. Image Processing
Image Settings

MiDAS 4.0 includes a standard set of controls for modifying image properties sugh as
brightness, contrast, and gamma correction. In the Image Processing tab of the Control
Panel, you can adjust these parameters, save the settings, and load previously saved
settings. The main purpose of image processing is to optimize the image for analysis.

There are two sets of identical sliders, one for color images, above, and one for
monochrome (black and white) images below. For color images, the red, green and
blue channels are modified as a group by default and controlled by a single slide
control. To modify the RGB channels separately, double click on the slider control.

The slider control will separate into individual red, green, and blue sliders that can be
adjusted independently. The slide controls for monochrome images cannot be
seaparated into RGB channels. The various image settings are:



Brightness Adjusts the brightness of the image. Moving the
slider to the right will increase brightness by
moving pixel intensity values towards white
(255). Moving the slider to the left will decrease
brightness by moving pixel intensity values
towards black (0).

Contrast Adjusts the contrast of the image. Moving the
slider to the right will increase contrast by
moving pixel values towards white (255) or
black (0). Moving the slider to the left will
decrease contrast by moving pixel values
towards gray (128).

Gamma Correction Adjusts the gamma of the image. Adjust the
gamma is similar, but not identical, to adjusting
the Exp./Log. slider. Moving the slider to the
right will increase the brightness of the image.

Exp./Log. Adjusts the image output using nonlinear
functions. Moving the slider to the right uses a
logarithmic palette, increasing the contrast in
dark regions and decreasing the contrast in light
regions. Moving the slider to the left uses an
exponential palette, increasing the contrast in
light regions and dcreasing the contrast in dark
regions.

Reverse For color images, click on any of the three
Reverse buttons to invert the corresponding
RGB channel. Red is reversed to Cyan, Green is
revered to Magenta, and Blue is reversed to
Yellow. For monochrome images, there is a
single Reverse button for inverting black and
white.

Display as B&W Converts color images to monochrome images
using the conversion factors indicated by the R,
G, and B sliders.

Save Allows you to save image settings into a
*.lut file (Look Up Table format) for
later use.

Load (from File) Allows you to apply a previously saved *.lut
file to the current video.

Reset Sets all adjustments to their default levels.
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Reversing Channels
You may convert images between color and monochrome and adjust the individual
color channels of the image. Note that all analysis engines use only monochrome
representations of images.

To reverse a monochrome image or individual channels of a color image, click on the
reverse buttons at the bottom of the color and black and white sections of the panel.

Reverse Changes the color palette such that whites and blacks are reversed. In
addition, for color images, each individual channel of RGB color is
reversed. Red is reversed to Cyan, Green is reversed to Magenta and Blue
is reversed to Yellow.

Converting between Color and
Monochrome

To display a color image as monochrome or to reset a monochrome image to its
original color (if recorded in color), the following options are available:

Display B&W / Display As Color Converts color images to monochrome images
using the conversion factors indicated by the R,
G, and B sliders. Once a video is converted to
black and white, the button will display Display
As Color, to revert back to an RGB (Red,
Green, Blue) image.

R Scale Amount of red channel to include when
converting from color to monochrome.

G Scale Amount of green channel to include when
converting from color to monochrome.

B Scale Amount of blue channel to include when
converting from color to monochrome.

Chapter 14. Image Processing 133



Saving Image Settings
Once you have finalized your Image Settings, you can save them for usage at a later
time. You can also apply these saved settings to another video image. For example,
you may optimize one image for tracking performance and then apply those same
image processing settings to all videos in the same experiment or application. The
image adjustment settings are saved in a LUT (Look Up Table) format for later
retrieval.

The save/load buttons are found at the bottom of the Image Settings control panel.

Save Save current settings to file. Image processing files have the *.LUT file
extension.

Load Allows previously stored image settings to be loaded for this video.

Reset Returns all image settings to their default levels.

Advanced Camera Settings
Some cameras have additional settings that will give the user added help in
configuring the camera to give the best possible image. These setting will affect the
sensor gain, controlling the on-board amplifiers to further increase the brightness of
the image. It is important to be careful in these adjustments, as too high of an amplifier
gain can result in a saturated image. The advanced settings are:

Binning Binning combines multiple pixels to form one larger pixel. This has two
effects: it will increase the brightness of the image, and it will reduce the
resolution. However, due to the geometry involved in the binning
process, the loss of resolution will be the inverse root of the sensitivity
gain. For instance for 2 x 2 binning the gain will be 4x, while the
resolution loss will be 1/2. For 3 x 3 binning the gain will be 9x, while
the resolution loss will be 1/3. The brightness is gained by capturing the
light over a larger area.

Gain The gain setting applies an amplification factor to the camera, boosting the
signal and noise levels. Gain is primarily used to compensate for low light or
bright light levels. Not all cameras have the same gain scales. Some express
gain as a multiplier and others as a dB gain level.

134 MiDAS 4.0 User Manual



Pixel Gain This is dynamic range amplification of the digital signal, before post
processing. It allows you to amplify the lower bits, which allows you
to amplify the darker portions of the image, or the higher bits, to
increase the amplification of the brighter portions of the image.

These functions are camera specific. For more details please consult your camera
manual.

Camera Color Adjustment
Some video cameras generate images using the Bayer format. To create a color image,
a pixel array must use separate sets of pixels, each filtered to different colors, normally
Red, Green, and Blue. When using the Bayer format, each of these pixels create a gray
scale image that corresponds to the intensity of that particular color. To display a color
image it then combines these three gray scale images, applying the amount of Red,
Green, and Blue based upon the amount of white (with white 255 being full saturation
of that particular color) within the corresponding gray scale for that particular color.
Put simply, each of three images is converted to a monochrome pattern, which instead
of being black and white, becomes Black and one of the primary colors. These are
then overlaid on top of each other, the result being a full color image. These Bayer
images are converted to color images using a set of nine color coefficients. These
color coefficients can be modified to account for color temperature, gray balance, and
color balance.

The coefficients for a given camera are set using the Color Adjustment window shown
below. This window can be accessed by right-clicking in the live camera display
window and selecting Camera Color Adjustment.

The buttons along the right side of the Color Adjustment window dialogue perform
the following operations:

Display Color / Display Bayer This button switches between displaying the
images in the raw Bayer format or in
normalized color. When displaying in color, the
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update rate of the live window will be slower
due to the added computations required for the
conversion to a color display. This button will
only effect the live window display.

Reset to Factory This button will reset the camera's stored
values, set by the manufacturer.

Load Settings The Load Settings button will allow you to
apply a set of previously saved settings. It is
important to use settings on only the same
camera type.

Save Settings Once you have made adjustments to the Color
that satisfy your needs, you can save these
settings to a file. This is useful when you are
setting up a new test with similar parameters.

Advanced / Basic The Color Adjustment window has two
different modes for the interface, the basic
version above, and the advanced version, which
allows for direct modification of the nine color
coefficients.

Undo This button will undo any changes you have
made since opening the Color adjustment
dialogue box.

Dismiss This button will close the window, keeping the
adjustments you have made.

There are three numbered sections along the left side of the window. Applying the
setting in this order assists in getting the best color balance.

The first section, Color Temperature, allows you to choose from the factory presets,
or enter into the Manual Settings that will allow for user adjustments. Factory Preset
utilizes the pre-loaded settings in the camera; this will give you an excellent starting
point for adjustments. Manual Settings are the user configured settings that can be
saved and applied at another time. The third selection in the drop down box is for
Daylight, which uses a different set of color temperature settings for natural light
versus artificial light.

Once you have selected Manual Settings or one of the lighting condition pre-sets, you
can make a coarse adjustment to the settings by applying the Gray balance. Using the
Gray balance you will select an area of the image in the live window that is close to
gray, or should be gray. Click on the Select Region button, then choose the area of
gray in the live image window. It is important to find an area close to gray, or the
balance will be shifted. Once you have chosen the area, you can then click the Apply
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Now button. This will set the red/green/blue values to bring the color inside of the box
to gray. These values will be applied to the entire image.

If after gray balancing, you wish to make some additional adjustment to the color, you
can modify the color balance sliders in the Channel Adjustment section. Within the
Channel Adjustment slider, values of 100% represent the value of red/green/blue as
specified in the Gray Balance section. In the above figure we show a red value of 52.
In Channel Adjustment ,100% means that the value used is 52. If the slider is adjusted
to 150% MiDAS 4.0 will use a value of 78. The Sliders will default to 100% and you
can adjust them as desired. If a slider is set to 0%, this will cancel the adjustments
made for that color in Gray Balance.

If you wish to perform additional fine adjustments to the color coefficients, you can
modify each of the coefficients directly using the advanced version of the color
adjustment dialogue. Under the Color Adjustment window, select the Advanced>>
button. The Advanced dialog displays the factory preset coefficients, which are in a
grayed box and cannot be changed, and the current color coefficients. There are nine
total coefficients. The reason that nine coefficients are used is the nature of the Bayer
method for color reproduction. In a color pixel array there is not an equal amount of
sub-pixels (the individual red, green and blue sensors on the array) for each displayed
color pixel. Generally 50% of the sub-pixels are green, 25% are Blue, and the
remaining 25% are Red. As a result we need to weight the intensity of each individual
sensor to balance the resulting image. Depending on the source of lighting utilized to
illuminate an image, that light will have a varying amount of intensity in certain areas
of the spectrum. To adjust for these spectral differences, we must vary the influence
each of these sensors has on the final image. These coefficients form a 3x3 matrix
used in Bayer decoding. The color balance sliders from the third section Color
Adjustment represent the multipliers for the red, green, and blue components, while the
3X3 matrix of coefficients adjusts how the colors are integrated.
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Appendix A. Persistence of
Settings
Persistence of Settings

The guiding principle for changing camera settings is to maintain as many settings a
possible and only change those values which must be changed to be compatible with
the user-defined setting. MiDAS 4.0 follows these rules when changing camera
settings:

If you change... Then... Frame
Rate

Resolution and
Active Area

Shutter Speed Max. Frames

Frame Rate The frame rate
is changed to
the new setting.

Resolution is
maintained if it
is compatible
with the new
frame rate. If
the resolution
must change,
the center of the
active area is
maintained
unless it
reaches the
border of the
sensor area, in
which case it is
shifted to
remain
completely
within the
sensor area.

The shutter
speed multiplier
(1x, 2x, etc.) is
maintained. If
the shutter
speed was a
custom setting,
the custom
setting (in
Âµsec) is
maintained, as
long as it is less
than 1x at the
new frame rate.

If the Max.
Frames value is
less than the
total number of
available
frames at the
new frame rate,
the Max.
Frames value
will stay the
same.

If the Max.
Frames value is
greater than the
total number of
available
frames at the
new frame rate,
the Max.
Frames value
will be set to
equal the total
number of
available
frames.

Resolution and
Active Area

The frame rate
does not
change.
Resolution
options are
listed in the

The center of
the active area
will be
maintained as
the resolution is
changed. If the

The shutter
speed is not
affected by
changes in
resolution and
active area.

If the Max.
Frames value is
less than the
total number of
available
frames at the



drop-down
menu based on
the selected
frame rate, so it
is not possible
to select
incompatible
resolutions.

border of the
sensor is
reached, the
active area is
shifted to
remain
completely
within the
sensor area.

new resolution,
the Max.
Frames value
will stay the
same.

If the Max.
Frames value is
greater than the
total number of
available
frames at the
new resolution,
the Max.
Frames value
will be set to
equal the total
number of
available
frames.

Shutter speed The frame rate
is not affected
by changes in
shutter speed.

The resolution
and active area
are not affected
by changes in
shutter speed.

Shutter speed is
changed to the
new setting.

Max. Frames is
not affected by
changes in
shutter speed.

Max. frames The frame rate
is not affected
by changes in
max. frames.

The resolution
and active area
are not affected
by changes in
max. frames.

The shutter
speed is not
affected by
changes in
shutter speed.

Max. frames is
changed to the
new setting.
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Appendix B. MiDAS Notes
MiDAS Notes allow you to add text notes to your projects. An Indice Note is linked to
an individual video frame or data point. A Global Note is linked to an entire video or
data sequence.

Creating MiDAS Notes

1. Open a video or video/data sequence.

2. Select MiDAS Notes from the Tools menu. The MiDAS Notes window will
appear.

3. Enter notes in the text fields. If you want to add an Indice Note, use the Play
Controls to advance to the desired video frame before entering the note.

4. Select Save MiDAS Notes from the File menu. Click OK when the MiDAS
Notes saved successfully dialog box appears. If you save an Indice Note, a green
square will be added to the bottom right corner of the video frame.



5. If you do not want to save your notes, click the Close Window button on the
MiDAS Notes title bar. A dialog box will appear, asking if you would like to
save your notes. Click No.

Opening Previously Saved MiDAS
Notes

1. Open a video or video/data sequence.

2. Select MiDAS Notes from the Tools menu. The MiDAS Notes window will
appear.

3. Use the Note Step buttons to browse through Indice Notes. The video will
advance to the corresponding video frame as you browse the Indice Notes.

Alternatively, you may use the Play Controls to find video frames with a green square
in the bottom right corner, denoting an Indice Note. Right-click on the green square to
open the MiDAS Notes.
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Appendix C. Video Explorer
Overview

The Video Explorer provides a convenient method of previewing and organizing video
and data files. The Video Explorer presents a complete Windows Explorer directory
panel along the left side of the screen and a thumbnail preview of each video and
corresponding data in the main area. The Video Explorer displays all the recognized
video files within the currently selected folder. You can also play the video files
within the preview pane.

Settings
There are a number of settings that affect how the Video Explorer will appear and
search for video files. These are set using the toolbar.

The Video Explorer toolbar consists of the following icons. All icons have screen tips.

Show Data Display Data in the preview pane.

Hide Data Hide data in the preview pane.

Show Trigger Frame Utilizes the trigger frame of a video as the
preview image.



Show First Frame Utilizes Frame #1 as the preview image.

Show Videos in Current
Directory

This limits the displayed images in the desktop
window to those in the selected directory.

Show Videos in Subdirectories This will display all videos in the currently
selected directory, as well as all directories
below.

Align Vertical Aligns video preview panes top to bottom.

Align Horizontal Aligns video preview panes left to right.

Compact View Displays only the Video preview with data (if
selected).

Normal View Display video and data (if selected) play
controls and video information.

Refresh the previews of available videos.

Zip Files Compresses a directory of videos. When
selected a dialog box will appear allowing you
to customize the compression.

Preview Pane
Multiple items are displayed for each video tile when the Video Explorer is set to
display in a Normal View. In a Compact View, only the video and data thumbnails are
visible.

Filename The filename of the video is displayed in the
title bar.

Current Frame Number The current frame number being shown is
displayed in the upper right corner.
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Video Thumbnail A thumbnail image of the video is shown on the
left panel.

Data Thumbnail or Timeline If data is present, a thumbnail drawing of the
data is shown beneath the video. If data is not
present, a timeline is drawn. The data thumbnail
or timeline may be clicked on to display a
different video frame.

Play Controls Standard play controls are provided for playing
the video. These include: rewind, play reverse,
stop, play forward, jump to end, and a button
for setting continuous playback.

File Size and Modification Time The file size and modification time are shown
on the right panel.

Video Information about the video length, size, and record
information is shown in the right panel.

Data Information If data is present, information about the data
record information is shown in the right panel.

Viewing and Playing Video and Data
Each video can be played by using the play controls underneath the data graph area or
by using the context (right click) menu.

You can also jump to any frame in the video by clicking in the data graph area.

Opening Video Files
There are multiple ways to open a video file from the Video Explorer window:

• Select the video(s) you wish to open. They will be highlighted in green. Hit Enter
and the video(s) will be opened in MiDAS 4.0. You will not be switched
automatically to MiDAS 4.0, so you may open more videos.
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• Double-click within the video image that you wish to open and a video window
will open.

• Drag and drop the video image that you wish to open onto any Project window.

Compressing Directories
Often it is necessary to move collections of videos from one computer to another.
Since many videos have very large file sizes this can be difficult. The MiDAS 4.0
Video Explorer can be used to compress directories of Video Files to ease the moving
of large numbers of large files.

First select the directory you want to compress, then click on the Zip Icon . When
the dialog opens you will be able to input the desired filename, as well as the type of
archive you would like to use, the default is .zip.

Below the File Name and Save as Type, are 3 sections.

Compression this allows you to choose the level of compression, this
will effect the speed at which the process will take.
Slower speeds mean higher compression, as well as
smaller file sizes.

Multi-volume This will allow you to span the archive over multiple
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files. It is useful if you plan on archiving the files to
CD or DVD, or if you are limited on the total size of
e-mail attachments. Once you've selected the checkbox,
manually enter the maximum size you require.

Associated File The MiDAS 4.0 will automatically archive those file
extensions associated with MiDAS data and MiDAS
notes. If you need to add additional files you can use
the buttons to add and remove the extensions you wish
to be archived. Restore Default Extensions will restore
the selection list to only those MiDAS 4.0 file
extensions.
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Appendix D. MiDAS 2.0
Conversion Wizard
Overview

Previous versions of MiDAS utilized data file formats different from the .mdat
format currently used in MiDAS 4.0. MiDAS 2.0 utilized the .au2 file format. For
your convenience, you can utilize the MiDAS 2.0 Conversion Wizard to organize your
older MiDAS 2.0 videos and associated data files into a MiDAS 4.0 Play Group file.

1. Select MiDAS 2.0 Conversion Wizard from the Tools menu.

2. Under Source - MiDAS 2.0 Video File, click on the Browse... button and
navigate to the MiDAS 2.0 video file you wish to include in the play group. Note:
It is important that the associated .au2 data file have the same name as the video
file.

3. Under Destination - Playgrp file, click on the Browse... button and navigate to
where you would like to save the .playgrp file. It is recomended that you save
the playgroup file in the same directory as the video.



4. After you have selected the file and destination, click Finish. MiDAS 4.0 will
create and open the play group.

Note: This wizard will only work with the .au2 file formats.
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Appendix E. ProAnalyst 3-D
Capture Wizard
Overview

MiDAS 4.0 can be used to acquire video for 3-D analysis using software packages
such as ProAnalyst 3-D Professional Edition. The ProAnalyst 3-D Capture Wizard
assists you in capturing calibration images and videos from multiple cameras. These
images are loaded in ProAnalyst as a *.mpj project file.

Calibration is required in order to compute precise 3-D coordinates of points in the
camera view. Calibration requires a calibration fixture. This fixture can be a standard
fixture supplied by Xcitex or a custom-made piece with geometric pattern. This fixture
is placed in the field of view of both cameras. All reference points on the fixture must
be visible by both cameras.

Prior to capturing the videos of the actual event for measurement, a set of calibration
images must be acquired. The fixture must be placed in the field of view of both
cameras. Then capture an image of the fixture with each camera. ProAnalyst can
utilize these images to determine the position of the cameras and their relationship to
each other in 3-dimensional space. If the cameras are disturbed in any way after these
calibration images are taken, a new calibration must be computed. If the cameras are
not moved between events, the same calibration may be used for each event.

The ProAnalyst 3-D Capture Wizard is located in the Tools menu.

Using the ProAnalyst 3-D Capture
Wizard

1. The ProAnalyst 3-D Capture Wizard will guide you through the process of
capturing calibration images. The first step is to open two cameras. Select your
cameras from the drop-down menus. Click Next.



2. Use the live images from each camera to adjust their fields of view. Make sure all
reference points on the fixture are visible by both cameras. Within this window
you can use your mouse to pan the image, and the + and - buttons to zoom the
image. Once you have framed the image as desired, click Next. An image from
each camera will be captured and stored into memory.
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3. The wizard will open the Project Filename dialog. Choose a filename for your
ProAnalyst 3-D project, and click Next. The Project file will be created and the
two camera calibration images will be saved to the directory.

Appendix E. ProAnalyst 3-D Capture Wizard 153



4. A confirmation dialog will appear. Click Next.

5. A guidance message will appear. Read the instructions and click Next.
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6. A dialog box will appear telling you that you may now capture your event. Click
OK.

7. The ProAnalyst 3-D Capture Wizard will close while you capture your event.
Make sure the positions of the cameras have not changed prior to capturing the
event. After you finish recording, keep the video windows open and select the
ProAnalyst 3-D Capture Wizard from the Tools menu again.

8. The wizard will allow you to choose between saving the videos and restarting the
3-D capture process. If your recording was satisfactory, click Continue and Save
Videos.

9. A dialog box will appear notifying you that the current videos will be saved.
Click Next.
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10. The videos will be saved in the previously saved ProAnalyst project folder. The
window will inform you of the file names and their locations. Click Finish.
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11. A success message will appear. Click OK.

12. You may now start ProAnalyst and begin analyzing these videos.
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Index
Symbols
3-D capture wizard (see ProAnalyst 3-D
capture wizard)
5B+ rack, 61

A
Active area, 40, 139
Actual image size, 20
Analysis tab, 119
AU1 file, 109
AU2 file, 109
AU3 file, 109
Auditing, 52
Auto-download (see Automation)
Automation, 51

Auditing mode, 52
Basic mode, 51
Custom mode, 53
File name, 54
Maximum Download mode, 53
Starting, 56
Stopping, 56
Time Lapse mode, 52
Timed reset mode, 52

AVI file, 108

B
Base synchronization, 114
Basic automation, 51
Bayer format, 135, 135
Binning, 134
BMP file, 109
BNC breakout box, 61, 74
Brightness, 131

C
Calibration, 115, 115

3-dimensional, 151
Coordinate system, 116
Hide, 118
Scale, 115, 125
View, 25, 118

Calibration images, 151

Calibration tab, 115
Calipers, 125

Calibration, 125
Deleting, 129
Distance, 127
Length, 126
Measurement points

Deleting, 129
Moving, 128

Velocity, 127
CAM file, 109
Camera drivers, 4
Camera hardware installation

Ethernet, 5
IEEE1394, 5
PCI, 4
USB, 5

Camera view window, 18
Cameras

Active area, 40
Color adjustment, 135
Configuring, 37
Image settings, 134
Information, 36
Opening, 35

Capture wizard (see ProAnalyst 3-D
capture wizard)
CFG file, 109
Channel Adjustment, 137
CLR file, 109
Color adjustment

Cameras, 135
Videos (see Image processing)

Connection assistant, 44
Continuous playback, 114
Contrast, 132
Control panel, 28

Analysis tab, 119
Automation tab, 51
Calibration tab, 115
Control tab, 38
Docking, 28
Hide/Show, 29
Playback tab, 111
Video trigger tab, 47

Conversion wizard, 149
Coordinate system, 116
Custom automation, 53



D
Data

Graphing, 25
Opening, 111
Playback, 25
Recording,
Reference data point, 97
Saving, 105

With video, 106
Data acquisition

Hardware, 59
Master clock, 60
Multiplexed, 61, 72
Sample rate, 72, 98
Theory, 59

Basics, 66
Waveform per Frame, 60

Data acquisition hardware
Connecting, 63
PCI installation, 5
PCMCIA iinstallation, 7

Data Acquisition hardware
drivers, 7

Data cards
Configuring, 73
Opening, 73

Data centric mode, 98
Data Information, 145
Data Rate,
Data window, 18, 25

Configure, 27
Cursor mode, 26
Pan mode, 26
Zoom mode, 26

Device selection, 35
Display settings, 13
Distance, 127

E
Edit menu, 15
Exponential correction, 132
Exposure time, 96
External event trigger, 43

F
Falling edge, 43
Feature tracking, 119, 122

Clear all forward, 25
Exporting, 120, 123

Features, 121
Hide, 122
Labels, 121
Lock, 122
Markers, 121
Naming, 121
Settings, 122

File formats, 108
File menu, 15
Frame rate, 37, 139

G
Gain, 134
Gamma correction, 132
Graph

Configure, 27
Gray balance, 136

H
Hardware connection (see Connection
assistant)
Help menu, 16

I
Idle button, 40, 45
Image calibration (see Calibration)
Image processing, 131

Load, 132
Reset, 132
Saving, 134

Image sequence
Saving, 105

Infinite reset, 54
Installation, 9
Invert colors, 132, 133

J
JPG file, 109

L
Layout toolbar, 17
Length, 126
Live button, 40, 44
Loading files, 101
Logarithmic correction, 132
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Look-up table, 132
LUT file, 109 (see Look-up table)

M
Main toolbar, 16
Manual tracking (see Feature tracking)
Max. frames, 140
Maximum download, 53
MDAT file, 109
Measurement point (see Calipers)
Memory buffers, 93

Circular buffer, 93
Menu bar, 15
MiDAS 2.0 conversion wizard, 149
MiDAS notes, 141

Opening, 142
Saving, 141

Monochrome, 132
MPJ file, 151
Multiplexing, 61, 72

N
Notes (see MiDAS notes)
NTV file, 109

O
Open camera, 35
Opening files, 111
Origin, 116

P
Pan, 23

Data window, 26
Pixel gain, 134
Play controls, 32, 112

B checkbox, 33, 114
C checkbox, 33, 114
S checkbox, 33, 114

Play Controls, 145
Play Group

Opening, 111
Play group files, 107

Saving, 107
Playback

Data, 25
Jump, 34
Zero, 34

Playback rate, 33, 113

Average, 113
Playback ratio, 33, 113
Playback tab, 111
Playback window, 18
PLYGRP file, 109
Point tracking (see Feature tracking)
ProAnalyst 3-D capture wizard, 151
Program options, 29

Camera scanning, 29
General settings, 29

Program Options
Camera connections, 29

Program window, 14

R
Record button, 40, 45
Record options, 30

Data,
HG,

Record tab, 38
Recording, 35

Controls, , 44
Multiple cameras, 151
Settings, 139

Reset count, 54
Resolution, 38, 139
Reticle, 23, 23
Reverse colors, 132, 133
RGB image, 133

Convert to monochrome, 133
Rising edge, 43
Rulers, 23

S
Sample Rate,
Save play group files as, 107
Save video/data file as, 101
Saving, 101

Data, 105
Image sequence, 105
Video/data, 106
Videos, 101

Subset of frames, 103
Video compression, 103

Scale, 115, 125
Sensors

Types, 67
Differential grounded, 69
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Differntial floating, 69
NRSE, 70
RSE, 71
Single-ended floating, 71
Single-ended grounded, 70

Shutter speed, 37, 140
Status bar, 18
Stop button, 40, 45
Synchronized playback, 114
Synchronized Save List, 106

T
Tabs (see Control panel)
Terminal block, 61
TIF file, 109
Time lapse, 52
Timed reset, 52
Title bar, 14
Toolbar, 16
Tools menu, 16
Tracking (see Feature tracking)
Trigger adjust, , 42
Trigger button, 40, 45
Trigger type, 43
Triggering

Buffer length, 98
Percentage, 94, 98, 98, 98
Post-trigger, , 42, 94, 98
Pre-trigger, , 42, 94, 98
Reference data point, 97
Reference frame, 95, 97
Settings, 42
Trigger Type,
vs. Stop, 97

U
Units

Converting, 115

V
Velocity, 127
Video

Reference frame, 97
Saving

With data, 106
Video centric mode, 98
Video controls toolbar, 17
Video explorer, 143

Video Explorer
Information, 144
Opening Video Files, 145
Settings, 143
Viewing and Playing, 145

Video Information, 145
Video measurement toolbar, 18
Video tools toolbar, 17
Video trigger, 47

Configuring, 47
Falling level, 48
Rising level, 48
Training count, 48

Video window, 18
(see also Camera view window)
(see also Playback window)

Video Window, 19
(see also Camera View Window)
(see also Playback Window)

Videos
Analyzing, 119
Opening, 111
Playback, 112
Previewing, 143
Recording, 35
Saving, 101

Image sequence, 105
Video compression, 103

Thumbnails, 143
Trimming, 103

View menu, 15
Visible region size, 20

W
Window menu, 16

X
X axis, 116
XLS file, 109

Y
Y axis, 116

Z
Zip files, 146
Zoom, 23

Data window, 26
Fit in window, 23
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View actual, 23
Zoom box, 22, 23
Zoom window, 18
Zoomed image size, 20
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